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1. Introduction

FoodStar is supporting software for the DST milli-PU temperature and pressure
recording Data Storage Tag. FoodStar can run under versions newer than Win2000. This
manual takes you step-by-step through the program installation, hardware connections
and use of the FoodStar Program.

This manual guides the users of DST milli-PU through the operation of the recorder.
Setting the operating parameters as well as data retrieval requires access to a PC
computer with a standard RS-232C serial interface or USB.

The users of FoodStar will receive free updates of the software. Updates of FoodStar will
be available for free download at: http://www.star-oddi.com/Online-Support/Software-

updates/

Please note that the downloaded file has to be installed into the existing FoodStar folder.
The update alone is not a complete program and therefore will not work like that. Follow
the instructions on the update website for correct installation.

DST milli-PU is a compact microprocessor-controlled temperature and pressure recorder
with electronics housed in a waterproof housing.

The sensors are located in the cup as shown on the diagram below.

/ Pressure (depth) sensor

Temperature sensor

Figure 1.1 DST Sensors
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It is extremely important that the areas where the sensors are located are kept free from
other materials to be pressed against it. This is to allow free flow of water/liquid to the
sensor.

Please note that the pressure sensor membrane is fragile, and sharp objects should not
be pressed against it. If the logger needs to be pushed out of the plastic housing, be
careful not to push on the pressure sensor membrane, but it is ok to push on the upper
sides that are around the membrane.

Upper

L |

Figure 1.2 DST inserted into Plastic Housing
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2. Program Installation

This chapter describes how to install and uninstall the FoodStar software on your PC
computer.

2.1 Install

To download FoodStar visit www.star-oddi.com/downloads. To install the program, follow
the automatic InstallShield Wizard.

Follow the instructions on the screen. You will be prompted for a directory name for your
FoodStar program.

To run the program after installation, do one of the following:

Type in your product key. Please keep the product key in a safe location as you may need
it for future use. The product key works for multiple computers on the same network.

2.2 Uninstall
To uninstall the program, do the following:

Click on the Start button in Windows.

Go to Settings and Control Panel.

Choose Add/Remove Programs.

Choose FoodStar and click on Change/Remove, and ‘Yes to all'.

PONPE
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3. Preparation

This chapter describes preparations that should be carried out before connecting to the
recorder.

Start FoodStar and the following window appears:

Figure 3.1 FoodStar Main Window

If you are starting the software for the first time, you will be asked if you want the
Connection Wizard to open automatically each time you start FoodStar. If you change
your mind you can always change the settings under Settings-Options-Startup.

3.1 Configuration of the Communication Port

It is necessary to define which USB or serial port on your PC computer you will use for
connecting the Communication Box.

Using the USB Serial Converter

If you are using the USB serial converter you will need to download and install the driver
from www.star-oddi.com/downloads.

©2014 Star-Oddi. All Rights Reserved Page 8
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The easiest way is to use the Connection Wizard. When opening the software the
following window appears:

Connection Wizard

If using a communication box:
Connect the box to the computer and insert the DST
If using a StarCom cable:
Connect cable between the recorder and computer

Close l

Figure 3.2 Connection Wizard

Connect the USB cable and the selected port will appear in the wizard pop-up window

(see figure 3.2).

The serial port can also be defined manually in the following way:

1. Choose the Communication command in the Settings menu.

The Communication definition dialog box appears.
. Select a serial port for communications.

2
3. Choose the OK button.

i) Communication Definition

Select communication port

* COM1

Port enable / Power ;-
& ON
" OFF

oK

™ COM3

i Cancel :

Figure 3.3 Communication Port Configuration
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After you plug in the USB cable you will see a new communication port in your device
manager, called Prolific USB-to-Serial Comm Port. Make sure that the port is enabled

and select the appropriate port in Mercury.

£, Device Manager

File  Action Yiew Help

S 2 A =sRBa

+- Iy Computer
+-age Disk drives
¥ @ Display adapters
+ i DYDJCD-ROM drives
+- 9 Human Interface Devices
+-{=%y IDE ATAJATAPT controllers
+|-z» Keyboards
+-1 ") Mice and other pointing devices
+- @ Monitors
+- B8 Network adapters
=& Ports (COM &LPT)
néyi Communications Port {COML)
- ECP Printer Port (LFT1)
F‘.e Intel{R} Active Management Technology - SOL (COM3)
& Prolific LISB-to-Serial Comm Port (COM4)
+ ﬁ Processars
+-®), sound, video and game controllers

+- by System devices
+ Universal Serial Bus controllers

Figure 3.4 USB Communication Port in Device Manager

Using the Serial Port

To check which communication ports are available on your computer, open your Device
Manager. On Windows XP you can do it following way: Control panel > system >

hardware > device manager.

Under Ports you can view all available ports. Make sure that the port you are intending to
use is enabled: right-click on the appropriate port and select properties. Under Device

usage it should state use this device (enable).

Communications Port (COM1) Properties

Geneed | Port Settngs | Driver | Detafis | Rewcusoss
3 Comenurcanors Port [COM1)
Doves ype Pots |COM A LPT)
Marvlachaes |Standard port types|
Location
Device siohu

Thiz devios is wacking propedy.

staf the doubieshootet

on IrtedR} LCHSDD LPC Inteface Controber

W pors e having problems seth e devace, chck Troubleshoot 1o

l Troubleshoot
Devce vrags
Uze the device |ensblel v
[ o ][ Cace |

7%

Figure 3.6 Enable Communication Port
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4. Communication Box

This chapter provides details concerning the Communication Box and how to place
recorder in the box prior to connection.

4.1 Communication Box

The DST Communication Box is a PC-RS-232C compatible communication interface,
specially designed to communicate with DST recorders wirelessly via RF (radio
frequency). A USB converter plug is optionally available for the Communication Box.

The Communication Box has three diodes:

1. Red - shows that power is fed from the power supply to the Communication Box.
2. Yellow - shows that FoodStar has made connection with the box, the appropriate
DST has been selected as a recorder type and that correct COM port has been

selected.
3. Green - shows that recorder is in correct position for seeking connection.

Connect the serial cable between the serial port of the computer and the Communication
Box. Plug the power supply connection to a power-socket. The voltage from the power
supply should be set to 9V, although there is no damage to use up to 20V. Before
inserting the power plug into the box, it is important to note that the polarity should be:

-(O+ (minus on the outside and the plus on the inside)

The polarity is usually shown where the arrows meet on the power plug, and the power
supply. After the power supply has been connected to the Communication Box, the red
light should be on. After FoodStar has been started, the yellow light should be on (if
correct COM port is selected).

The box will power the recorder while communicating with the PC. In case the battery is
dead, the PC and interface are still able to connect to the recorder and retrieve data.

4.2 Connection Point

In order to get the green light, the red and the yellow light must be on.
The recorder is inserted into the hole of the box as shown in the figure below:

©2014 Star-Oddi. All Rights Reserved Page 11
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/ DST milli-PU
Communication Box

L

Figure 4.1 Inserting Recorder into the Communication Box

If the recorder has been recording in a wet environment, then please wipe it dry before
inserting it into the box. The spherical end of the recorder faces down and flat end faces

up.
When the green light is on, communication can be established with the software.

If the recorder fails to connect, please refer to the Troubleshooter.

4.3 COM Connection

&) Communication Definition L O | E S

Select communication port

* COM1 " COM3

Port enable / Power
+ ON
" OFF

DK|

Figure 4.2 Communication Definition

Choose Settings-Communication-Serial Ports to display available ports (see figure
4.2). Com ports up to COM255 can be selected.

©2014 Star-Oddi. All Rights Reserved Page 12
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4.4 Connection Wizard

Connection Wizard

If using a communication box:

If using a StarCom cable:

Connect the box to the computer and insert the DST

Connect cable between the recorder and computer

COoM14

COoM1

Com

Figure 4.3 Com Port Wizard

Choose Wizards- Connection Wizard. Connect the USB cable and the selected port
will appear in the wizard pop-up window (see figure 4.3).

©2014 Star-Oddi. All Rights Reserved

Page 13



Distributed By MicroDAQ, LLC  603-746-5524 www.MicroDAQ.com
User Manual FoodStar Graphic Supporting Software

5.Using DST - Tutorial

This chapter guides users in 8 quick steps through the process of utilizing FoodStar to
set up DST milli-PU prior to recording and data retrieval.

5.1 DST milli-PU Set Up

Step 1 - Start Program

Start FoodStar as described in chapter 2. Remember to carry out the software
preparation outlined in chapter 3.

Step 2 - Connect

Connect the Communication Box as described in chapter 4. Insert DST milli into the hole
in the box, and twist the recorder until the green light illuminates on the box.

Step 3 - Connect to the Recorder

Insert the DST into the box, the selected com port will turn green in the Connection
Wizard window.

Connection Wizard

Select the green com port

COM14 COM1

Close |

Figure 5.1 Connection Wizard

You can either click once on the selected port and select Next or double-click on the
port. If you are not using the wizard choose the Recorder menu and the Connect
command.

©2014 Star-Oddi. All Rights Reserved Page 14
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The window in figure 5.2 appears.

Connecting and Retrieving ID

E:\Testh71a801\UPAUST7S
Making the MED file..
Retrieving RAM data..
Making the MRD file..
Testing power-down..
Reading Clk-data

Making the RID file..
Making the RIT file..
Making the RCI file..

Connecting to recorder 1 oK
Retrieving recorder EP-ID.. 0K
Testing recorder EP-ID for type.. oK
Confirming type & version.. 0K
Retrieving recorder RID.. oK
Making CRC test.. 0K

Created recorder data-directory:

oK
oK
oK
oK
oK
0K
0K
0K

T

Figure 5.2 Connecting and Retrieving

Once the connection has been established, a window appears with information on the

recorder’'s mode (see figure 5.3).

Connection OK @

1 The recorder is on-line!
The recorder was in sleep mode

oK

Figure 5.3 Connecting to the Recorder

Press OK. The Recorder is now on-line, as indicated at the bottom of the FoodStar

window.

©2014 Star-Oddi. All Rights Reserved

Page 15



Distributed By MicroDAQ, LLC

User Manual

603-746-5524

www.MicroDAQ.com

FoodStar Graphic Supporting Software

Logger type

™~

Battery life. Place
the mouse here to
see the remaining
battery life in %

Amount of
memory used

v
/|

Recorder Mode

Status of Recorder

Recorder Wizard
DA

' Type: DST milli PU-T

N | Serial: M15111 «— | Program and start recordery | | program and
5“Battery Remaining: 74% e start recorder
— W 1\ ) o
101 Retrieve recorder data
| Memory Used: 0% '\\\ Retrieve
oy

' Mode Status

"2,

2
| Recordgeflas in sleep mode
Initjated without starting

=
-~? Disconnect recorder

P

&=

L —

Serial number

Recorder Data

Disconnect Recorder

I Close

Figure 5.4 Recorder Wizard

FoodStar checks which version of firmware is in the recorder. If the software does not
recognize the firmware the user will be asked to update FoodStar as there might be a
new functionality in the firmware which FoodStar does not support.

Connection Time Registration

Each time FoodStar connects to a Recorder, the PC time and recorder time is registered
to a binary file, with a CLK extension. This information is also saved to a text file with the
extension CCT.

Another text file is created with the extension CCD, containing various information, for
example on previous connection and time comparisons, depending on the status of
recorder.

If a previous CCT file exists and the recorder was in sleep or slumber mode, a PC vs.
recorder clock comparison is calculated, indicating difference in seconds and ppm.

If the recorder was in measurement mode, then a drift calculation is performed, based
upon PC-time comparison to the recorder’s clock and measurement sequence.

The RIT file contains partly the same information as the CCD file.

Upon retrieving date from a recorder and converting the data, the last measurement
retrieved time and the next scheduled measurement time is compared to the PC time. The
results are added to the CCD file and the MIT file.

Note: If the retrieved number of data does not match the last measured number of data,
erroneous results are to be expected.

©2014 Star-Oddi. All Rights Reserved
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Step 4 - Set New Measurement Parameters

(If the recorder has already been set up to record data and you want to retrieve data, go
directly to step 6).

Select Program and start recorder in the wizard and select which interval, single or
multiple, you want to use (see figure 5.5).

’ =)

(+ Single recording interval {default):

.

(" Multiple recording intervals

OK Cancel

Figure 5.5 Intervals

If you are not using the wizard choose the Edit menu and the New Measurement
Sequence Definition command. The following window appears:

(&) Set New Measurement Sequence o= ==
Measurement Interval Time

Start Ti
art Time a B)
Hours E2]
Start date: 17.10.2014 B~ -
: =)
Minutes 0 =

(&) (&)

Start time: Hour 15 = Min 5 ) coconde 11 [%

Set Mode [ Use Template ‘ Primary / secondary - definition

@ Single mode lﬁ
se Defau
-, Multimod ' Temperature as primary
ulti mode 7
Previous
Pressure/Depth as primary

0 @
| =

@ TD normal

[7] Save this NMS definition as a Template (file)

‘ 0K ‘| Cancel |

Figure 5.6 Measurement Sequence Definition

Select the start time of recordings (date-month-year, hours-minutes). The start time of
the new measurement sequence must be set at a minimum of three minutes in advance.
Set the sampling interval (hours-minutes-seconds).

©2014 Star-Oddi. All Rights Reserved Page 17
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If the user wants to program several recorders with the same sampling interval and start
time, it is recommended to select Multi mode. By choosing Multi mode, the settings are
fixed; giving each recorder connected to thereafter, the same settings. The recorders
connected to, following the first recorder; automatically get the same settings as the first
recorder. This saves time in the programming process. The multi mode can be
deactivated by clicking Cancel when connecting to the recorder (see figure 5.7).

51

| = ‘| The recorder “s new measurement sequence settings are:
= Start time: 17.5.2011 16:50:00
Measurement interval [hms]: 00:00: 10

Cancel I

Figure 5.7 Multi Start Mode

For programming more than one sampling interval, please refer to chapter 9.Multiple
Intervals.

With TD normal, temperature and depth will be recorded as pairs at each sampling. The
user has the option to select either temperature or pressure/depth as a primary sensor,
taking more frequent measurements for one of the sensor. The purpose with this feature is
to save memory size, increase recording period, and get more data on the sensor that is
of more interest (primary sensor). In this case, a secondary counter can be defined, which
can only be odd numbers. If for example pressure/depth is selected as a primary sensor,
and the number 3 is defined as a secondary counter, the temperature will only be
recorded every third time when pressure/depth is recorded, and the majority of the
memory is used for pressure/depth recordings.

The three buttons Use Template, Use Sequence, and Previous are not commonly used,
but can be handy when wanting to use a previously programmed sequence. To read more
about templates see chapter 8.12 Templates.

After the settings have been selected, press the OK button.

©2014 Star-Oddi. All Rights Reserved Page 18
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Step 5 - Start a New Measurement Sequence

If you are using the wizard, the software will automatically start the new measurement
sequence (start recording) and disconnect the logger. If you are not using the wizard
choose the Recorder menu and Start New Measurement Sequence command. The

window in figure 5.8 appears.

Start New Measurement Sequence

Figure 5.8 Start New Measurement Sequence

Once the new measurement sequence has been downloaded into the recorder, a window
appears on the screen in order to verify the settings (see figure 5.9).

Start New Measurement Sequence Activation |E|

The recorder’s new meazurement sequence settings are:; - )
[

Start time: 02/06/2009 14:31:50
M easurement interval [hms]: 00:00:10

OF. [ Cancel ]

Figure 5.9 Start New Measurement Sequence

Press OK and the recorder will be in Measurement Mode.

©2014 Star-Oddi. All Rights Reserved Page 19
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NMS Calculation
Upon setting up a NMS the estimated measurement sequence is calculated and memory

and battery energy usage predicted. The results are written to a text file, bearing the
recorder name with a NMS extension. If a recorder has not been selected then the file
bears the recorder type name, still the NMS extension.

The file is placed in the FoodStar\NMS directory.

An example of the *NMS file is shown in fig. 5.10.

Figure 5.10 Results from NMS Calculation

When starting the recorder in a NMS, the *RDT file now shows the sequence settings,
plus information on the sequence time duration and battery usage (same as in the *NMS

file).

©2014 Star-Oddi. All Rights Reserved Page 20
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Step 6 - Retrieve Data

When connecting to a logger after a measurement period, the following window appears:

(.

==

Retrieve recorder data?

.................................

No

[ Remember this setting

Figure 5.11 Retrieve recorder data

Click Yes if you wish to retrieve the data, click No if you would like to retrieve it later.

If you want the software to automatically retrieve data upon connection, check the

Remember this setting option.

Select Retrieve Recorder Data in the wizard. If you are not using the wizard choose the

Recorder menu and the Retrieve Data command. The following window appears:

Retrieve Data from Recorder

Retrieving recorder |D..
Testing ID..

Retrieving data..
Making the 1. MIT file..
Converting the data..

Bytes received:
Time (min:sec):

Packs received:
Resent packs:

Receive errors:

5000 of 5000
0:47 of 0:52
20 of 20

0

0

: Cancel data retrieval

Figure 5.12 Retrieve Data from Recorder

The window in figure 5.12 shows the data retrieval progress in bytes, time elapsed and

number of packs received.

©2014 Star-Oddi. All Rights Reserved
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Data will be uploaded from the recorder and presented in graphical and tabular form.
With default settings, FoodStar automatically creates a sub-directory in the FoodStar
directory, named after the DSTmilli. In the DST milli-PU directory, a directory named after
the recorder’s serial number (Mnnnn) is created. All files related to the recorder are
automatically saved in the serial number directory. The default data directory can be
viewed in the Settings menu, and Directories. The user has the option to define a new
data directory path if desired.

The data is retrieved in a non-destructive manner. This means that you can repeatedly
read the data without erasing it from the memory. Each time data is retrieved, a new file
will automatically be created. The name of the data file consists of the measurement
sequence number and the serial number of the recorder. The recorder cannot be loaded
with new settings if it contains data that has not been retrieved. This is a safety feature
which prevents data from being accidentally lost. New recordings overwrite previous
recordings that have been retrieved.

Once the data has been retrieved the following window appears:

Recorder Wizard

Type: DST micro-T
Program and start recorder

Serial: U7103
Battery Remaining: 75%
| |99 Restart recorder with the
Memory Used: 0% \ same sampling interval
N
Mode  Status 101 Retrieve recorder data

g

=~ Disconnect recorder

Recorder was in measurement
mode

Close

Figure 5.13 Recorder wizard

If you wish to start a new measurement sequence you can either program the logger with
a new measurement sequence by selecting Program and start recorder or Restart
recorder with the same sampling interval.

©2014 Star-Oddi. All Rights Reserved Page 22
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Step 7 - Disconnect

After the recorder has been set up for measuring, it should be removed from the
Communication Box. If the recorder is not put in measurement mode, it will automatically
go into sleep mode when removed from the box.

If you simply remove the recorder FoodStar will still have the recorder in on-line mode in
the program and will not allow the user to select another recorder or use certain options.
Select Disconnect Recorder in the wizard or Recorder > Disconnect to go into off-line
mode.

Step 8 = View Data

If data is retrieved from the recorder, a new file will automatically be created and opened
in graphical and tabular form. To open existing data files on the computer, choose the File
menu, Select Recorder command, and then the Select Measurement command. When
a data file has been opened, a new window appears with the data shown as a chart and a
table. The next chapter will describe in detail how to view and process data.

©2014 Star-Oddi. All Rights Reserved Page 23
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6. View Data

This chapter describes how to open a data file and the options available in FoodStar for
viewing the data.

6.1 Open Data
To open an existing data file that has already been retrieved, do the following:

1. Choose the File menu and the Select Recorder command. When a recorder has
been selected, its serial number will be displayed in the blue top bar of the
software.

2. Select the data file by choosing the File menu and the Select Measurement
command.

The name of the data file consists of the measurement sequence number (hnumber of
times the recorder has been set up to measure) plus the serial number of the recorder.
The ‘Measurement sequence no.” can also be seen at the bottom in the FoodStar
window. When the data file (.mid) has been selected, the chart and data tables are
opened. The following figure shows a chart and data table which have been opened:

0 Onawt "1IAN058 DAT (O FOODST AR\ MNE00T)" - =) EH
EEMN=uda <~ OwiEal | Tecknes ® n

11M6098DAT-Reconverted [ Het | Mober l Tire l'ﬂ'z‘-’ll"r’m}w il"'s,'* "R ul?nb;l‘l -

I —
EEATEEE
AT
& T
m—
ARSI e
oy
| -

3 3 S8 83T 3 I 8 I

ol 1803 Average: 26,205 . 4 > ¥

Figure 6.1 Chart and Data Tables of an open File

Import

Data files from other recorders than DST can be imported into FoodStar and viewed as
charts and tables. The imported file must be a text file with the extension DAT, and with
FoodStar's conventional DAT file structure. See more about data files and headers in the
Appendix.
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Buttons

When the chart is opened, buttons related to the chart are displayed.

Active Series List

This button can be useful when working with a multi-sensor recorder, in order to select
which parameters to display in the chart. For example, when working with a chart
displaying temperature and pressure recordings, the user can hide the pressure or the
temperature line in the graph. Click the button and the following window appears:

(0 seriestin =)

‘v“"‘: [V — Pasteurisation(PU)

WV — Pressure{bar) lLJ
[ Concel |

L Cancel
¥ ¥ — Co2(a/)

_ Dnly show
|| active table
columns

Figure 6.2 Series list

By selecting Only show active table columns only the selected series will be displayed
in the chart table.

The table columns can also been changed manually by right-clicking on the table (see

figure 6.3).
Number I Time ITemp(°C)IPress(bar)IPast:eur(PU)‘Coz(g/I)l
1597 11,12.2008 05:06:00 22,772 0,09 30,71 1,39
| 1598 11.12.200805:06:25 22,772 -0,09 30,71 1,39
v
T 1s0x] 1.4\ Y] Time 000 3071 1,3
| 102 1.1 Wl Femplg 0,09 30,71 1,39
- | v Press(bar)
1603 11.1 -0,09 30,71 1,39
— | v Pasteur(PU)
1604 11.1 -0,09 30,71 1,39
—~ | v Co2(g/m
1605 11.1 -0,09 30,71 1,39

Figure 6.3 Table
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=1l

Horizontal/Vertical Gridlines

These two buttons give the option of hiding/displaying the horizontal/vertical gridlines in
the chart.

A drop-down menu appears when clicking the horizontal gridlines button.

=1l
i Off
v Temperature(*C)
Pressure(bar)

Pasteurisation(PU)

Figure 6.4 horizontal gridlines

Select the series gridline.

A drop-down menu also appears when clicking the Vertical gridlines button

Off

@ Auto
Minute
Hour
Day
Month

Year

Figure 6.5 vertical gridlines

Select the minimum grid size.
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Data Point Marker
This button gives the option of displaying/hiding data points in the chart.

=

Histogram
The chart can be shown as histogram, displaying the distribution of values by percentage.

Click the Histogram button and the following window appears:

- =
Histogram end data statitics e
Selact Bin Settngs
Temperature("C)
= Defadt

s + Merperatire(*C) et

0%

6
E S0%
T esmrelbe)
B Ay

%

™ Pagteunsason(i)
1 [ 1 2
5083 W3 1145

Deta Statedcs

My 19053 Max: 61,145 Ranges 42,092

Meom 26,205 Median: 23,030 Ponts: 2001

ad Dev! 5,151 varance: 33,712 Mode: 23,053

Pt Close

Figure 6.6 Histogram and data statistics

Under Bin Settings there are two options, Default and User. Choose User to select the
number of bins and the minimum and maximum values you wish to display.

The Histogram can be printed out by clicking the Print button.

H

Save Window Data
Retrieved data is automatically saved, but if changes are made with the graph, for example

with the time scale, the save button enables the user to save the graph (as a DAT file).

Print Chart
The chart can be printed. Please see chapter 7 for more details.

Page 27
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&

Zoom Out

Click this button to zoom out the chart.

2

Zoom In
Click this button to zoom in on a previous view.

A

Adjust Axis
This button adjusts the axis in order to display all data within the zoomed timeline.

Open file in PatternFinder
Click this button to transfer data to PatternFinder

| Chart Edit
Chart Edit
By clicking this button, the following window appears:
» €t chant = o )
| & Senes |
Temperature{"C)
Pasteursaton(y WY Ve Prassure(dar)
| Co2(gf) ~‘ P &dd.. |
o Chart VvV v Pastour sason™J)
ol W Co2igh)
oo .
Legend Ttle....
Data v Vg.'uvqg..,r
Took £
Ansmabors
Export
Themes
I i Cote |

Figure 6.7 Editing Chart
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This button gives several options regarding the look of the graph. The axis can be defined
(max and min), titles and legend can be set visible. Under ‘Panel’ the colour of
background, borders and gradient can be selected. Under ‘Walls - Back’ the colours and
gradient of the graph itself can be selected. The ‘Visible’ option must be enabled to
activate the features. The graph can be exported in formats as jpg, gif, bitmap, metafile,
pdf, htm and svg.

Templates

Templates
If the changes have been made to the graph under ‘Chart Edit’, it is possible to save that
template. It is also possible to load a previously saved template (i.e. background).

o Display table completely

N
Partial table display

i
Hide table

Using the Mouse

Max and Min Values

Click once on any line in the chart, and the maximum and minimum values for that line
(sensor) are now shown. A straight vertical line should be visible in the graph (to the left).
By clicking on this line and holding the left button on your mouse down, the line can be
dragged through the chart and the data table will scroll along with the position of the line.

Zoom
The chart can be zoomed in on by holding down the left button of the mouse, and using
the cursor to create a box to the right, around the desired area to zoom in on.

Scroll the Chart
The chart can be scrolled upward, downwards and to the sides, by holding down the right
button of the mouse and moving the cursor in the desired direction.

Go Back to Initial View

To go back to the initial view of the chart, simply hold down the left button of the mouse
and make a box to the left with the cursor. The position of the box on the chart is
irrelevant.

Change the Axis
By double clicking on the X and Y-axis, the measurement time and temperature/pressure
range can be changed.
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Change the Title
To change the title of the chart, double click on the title of the chart

6.2 The View Menu

When a recorder has been selected, the files in the View menu can be opened.

Data Trend and Table

This view is automatically selected when data is retrieved or a data file is opened. If the
chart is closed, but a recorder has been selected, this command can be selected to view
the chart. The software will open the latest chart that was viewed for that recorder.

Recorder Information (RIT)

This is a text file containing basic information about the recorder, serial number,
production date, estimated battery life etc.

Recorder Calibration Information (RCI)

This text file contains information about the calibration constants of the recorder,
calibration range of the parameters. The range is both showed as decimal values (DV) and
unit values (UV). The survival pressure of the recorder is also shown.

Recorder Download Information (RDT)

This text file contains information about the measurement sequence that was last
downloaded into the recorder, including the start time, sampling interval and the
measurement sequence number.

Viewing Text Files

Under <View\Text files> the user can select a text file, via a file browser, for viewing.
This option is meant to give the (advanced) user a chance to view files that are not
directly supported for viewing in FoodStar, but are a part of the FoodStar documentation
system.
The files that the file browser accepts must have the following extensions:
o TXT
Frequently, users copy FoodStar data to text processors and spreadsheets, like
Word and Excel, and later save the data as TXT files for viewing in other
applications.
e INI
There are a number of INI files that FoodStar uses for store settings. These files
are described in the Appendix under ‘Information files’. The latest members in the
INI files family are the Template files.
e DAD
This is the original data file. It contains the raw data (in Ascii format) retrieved from
recorder. The DAD together with the MID are converted to the DAT file.
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A word of warning: The DAD file should never be tempered with, as that might give
cause to erroneous data conversion.

e CCT
Every time FoodStar connects to a recorder, the PC time and the recorder’s clock
data are stored in a <recorder name=>.CCT file.

e CCD
Every time FoodStar connects to a recorder, the PC time and the recorder’s time
are compared to the last CCT, if found, and stored in <recorder name>.CCD file,
<measurement sequence name>.CCD.

e NMS
Upon completion of a NMS editing session, estimation of memory and battery
usage is calculated and the results placed in a NMS file, which is then displayed to
the user.

SNMS LOG File

To improve the “Start New Measurement Sequence”, SNMS, indication/registration of
success or failure, a log file for each recorder type is placed in the FoodStar directory.
The log file name, for example for DST milli, is DSTM.LOG, i.e. the same naming
convention as for the type INI files.

Each time a SNMS is performed then the appropriate LOG file is updated.
The LOG file can be viewed via “View\SNMS Log file (LOG)"

In addition to the LOG file, if an error occurs during the SNMS, the MDD file is created as
a text file, with a description of what went wrong. This MDD file is displayed as a clear
message for the user (figure 5.6).

Usually the MDD file is a binary file, and the MDT is created from the MDD. If the SNMS is
repeated successfully the MDD file is overwritten and the MDT file created.

Recorder number i Qooz7
Measurement sequence number @ 6
Attenpted S3MNMS Date and Time: 3.12.20056 15:44:17

A& communication error occured when
transfering new settings to the recorder

Please note that the recorder was NOT started !
Please try again.

Figure 6.8 The MDD SMNS Error Message
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Measurement Data

Measurement Download Definition (MDT)
This text file contains information on data downloaded into the recorder for the
measurement file being viewed, including the start time and sampling interval.

Measurement Information (MIT)
This text file contains information concerning the measurement upload time, start date,
start time and number of measurements in the measurement data file.

Conversion Information (CIT)
This text file contains conversion information on the units and the data file format.

Statistics in CIT
The CIT has been enhanced with more detailed information on the converted data.

As can been seen in figure 6.9, the statistical data, that have been tabulated, are split into
two sections, the Unit values statistics and the Decimal value statistics. Values are given
for each parameter. The file can be viewed under ‘View\Measurement Data\Conversion
Information (CIT)..

A one line description/comment is available for the user to fill out in the Reconvert data
menu. This description is placed in line two of the CIT file.

Figure 6.9 Statistics in CIT File
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Out of Range (OOR)

This text file lists all the measurements that were outside decimal value calibration range,
as well as the unit value range. If correction has been performed according to the user
definition, then the corrected values are shown. See more in chapter 8.7 Out of Range.

Binary Data (DAB)
This file contains raw data of the measurements in the data file. Calibration files are not
calculated into the data.

View DAB Files as Trend

When converting the DAD -> DAT the DAB file is created simultaneously.

The DAB shows the recorder’s native data, i.e. decimal values in the range 0-4095. These
values originate from the recorders 12 bit ADC (Analog to Digital Converter).

It can be of interest to view the data in its native form, for example to spot saturation/out
of range intervals.

The DAB can be viewed graphically as a trend via:
‘View\Data Trend and Table\Decimal (Binary) data (DAB)’

& CAFODDSTARMEDIE L 1\L 11 MEOSGDAS -} ). il
EEL=00a T O[O Edn | Tesptates | o n
i M609SDAB

Y I

s

IrGINY

7S TR 0 TV ) [ 0] O D40 (30 €

Tenperatre

s

N

200 20 00 0 c40a 020 [ 30
Measioement tive: 10 12 2008 - 11122003

(0 0 R

Tirm Window Statetcs for Tangerature
Max: 1992 ot 18:00 Mn: 717 8t 2020 Average: 1154 » | om

Figure 6.10 DAB Trended

FoodStar cannot view older DAB files, and will inform the user to that effect, if an attempt
to view an older DAB file is performed. By reconverting the data, a viewable file is
produced.
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Binary Pressure Temperature Corrected Data (BPD)
Pressure measurement circuitries are calibrated against measurement errors due to
temperature changes.

Raw decimal values from the recorder can be seen in the DAB file. The first step in
converting decimal values to unit values is the circuitry temperature correction. The result
of this first correction can now be seen in a new file in FoodStar, *.BPD. The file contains
the corrected decimal value and the difference between the original value and the
corrected one.

The file can be viewed graphically or as tabulated lists.

Converted Data (DAT)
This is the text file for the converted data. The DAT file as well as the other text files can
be opened in other programs (Excel, Notepad, Word etc.).

Time Synchrone Data (TSD) and Rate of Change (ROC)
If the TSD and/or ROC file creation has been enabled under the Settings menu, then it's
possible to view these files.

You can find more in chapter 8.8 TSD and chapter 8.9 ROC.
You can find more about files in the Appendix.

FoodStar Log

FoodStar stores events in the file <FoodStar.log>. The events are:

e Recorder Connected

e Retrieving data from a recorder

e Uploading a measurement sequence to a recorder

e Recorder disconnected.
This file can be opened in FoodStar under <View/FoodStar Log> or by opening it with a
text editor.

Screenshots

By pressing the Print Screen keyboard button while in the application a screenshot of the
desktop is taken and stored in a subfolder, Screenshots.

The user can name the screenshot file as can be seen in the following figure.
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Screenshot @
Set filename
|My5creen5hu:ut

(04 | Cancel

Figure 6.11 Name the Screenshot

The screenshots can be viewed in View-Screenshots or by browsing the screenshot
folder, <\FoodStar\Screenshots\>.

The button also performs its normal operation which is to store the screenshot in the
clipboard.

6.3 Opening data in Excel

When retrieving data, the FoodStar software automatically creates a text file with the data,
called *.DAT. This text file can be opened in Excel and in other programs.

Joined Date and Time

Under the ‘Settings’ menu, ‘Preferences — Data File Format’, the default factory settings is
set to ‘joined date and time’. If this option is not disabled, the following is performed, for
opening data in Excel:

1. Excelis started.
2. The *.dat file is found from ‘File/Open’.
3. Excel comes up with the ‘Text import wizard'. This is a three step process:
a. No changes should be made in first step, so press the next button.
b. ‘Text qualifier should be set as ‘None’. Press the next button.
c. Column 2, that is date and time, is set as ‘Text". Press the finish button.
4. You can now create the graph with columns B, C and D.

Separate Date and Time

On the other hand if you have selected ‘seperate time and date’, under the ‘Settings’
menu, ‘Preferences — Data File Format', the following is performed:
1. Excelis started.
2. The *.dat file is found from ‘File/Open’.
3. Excel comes up with the ‘Text import wizard'. This is a three step process:
a. No changes should be made in first step, so hit the next button.
b. ‘Text qualifier’ should be set as ‘None’. Hit the next button.
c. Column 2 and 3, that is date and time, is set as ‘Text'. Hit the finish button.
4. Insert a new column between C and D. A new empty column (D) has now been
inserted between the time (C) and measurement values (now E).
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5. Left click the mouse on the D column, so that the whole D column is selected. Go

to ‘Format/Cells’, then ‘Number’ and choose ‘Number’. Press the OK button.

Go to cell D1.

Type the following in D1: =CONCATENATE (B1;” “;C1). Now you have the date

and time combined in one column.

8. D1 (the formula in D1) is copied down the D column. The D column can now be
used with column E and F, to create the graph.

No
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7. Printing

All charts and text files can be printed from the FoodStar software.

7.1 Charts

Open the chart you want to print out and select File-Print on the menu bar. The following

window appears:

-
g} TeeChart Print Preview

E=NE)

Orientation

The chart can be printed in either portrait or landscape format.

Margins

Orientation:
' Portrait
" Landscape
Margins (%)

Printer: HP LaserJet 2420 PCL 5e
S | 2
1 = 1 =

Reset Margins

[v View Margins

Detail:
More Normal

[ Proportional
[~ Smooth

v Setup... Print

I Close I

prEetLet
AR

PRERREEEEREEES
piegiiiiaiiiid

Figure 7.1 Print Preview

By changing the margins, the chart’s length and width can be re-scaled. The margins can
be varied by either changing the numbers given for the left, right, top and bottom margins,
or by moving the margin lines with the mouse by pressing and holding the left button as

the lines are dragged.

Move

When the cursor is located on the chart, a hand becomes visible. By clicking on the graph
and holding down the left button of the mouse, the graph can be moved around the page
to a desired position.
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Details

The size of horizontal and vertical gridlines as well as the texts on the X and Y-axis can be
re-scaled by using the scroll bar. The number of gridlines is increased when the bar is
moved to the left.

Another way of printing out a chart is opening the chart you want to print out and clicking
the Print Chart button on the chart bar.

7.2 Histogram

To print out a histogram, open the chart which histogram you want to print out and click
on the Histogram button on the chart bar. The following window appears:

Histogram snd data statitics ol

Temperature("C)

™ Pasteunsason(l)

an IOS0-4408  S2TIT-E1 045

Data Statmacs

My 19,053 Mo 61,145 Range: 2,092
Meom 26,205 Medan: 23,030 Ponts: 2001
Sad Dev: 5,151 varance: 33,732 Made: 23059

Pt | Close

Figure 7.2 Histogram

Click Print and the window in figure 7.3 appears:

r B
Output Options &J
Selected Printer
HP Laserlet 2420 PCL Se
—Report Destination
" Printer H
{ Preview Cancel
| v ———— Setup
Format’na.: Snapshot File _J
Options
Copies = !
]1 [ Dupie
S

Figure 7.3 Output Options
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To change the selected printer, click Setup and select another printer.

To see a preview of the print out, select Preview under Report Destination and click OK
(see figure 7.3 and 7.4).

7.3 Files

Pz
%) Report Preview | o

File Page Zoom

QG 14 > Page |1 of 1|

[ 10).

w FoodStar

30.08.11

13,4824

Histogram and Statistics

Fimam& \FOODSTARMOOSRY1 1111 1MO088 DAR
Timwanga10 12 200818:01:0001 1 12 200807 0420

Mensuremants 1102001

Tempatature

Romes(Y)
s §¥%8 28838

| f—

"t-m2 1227 - 14w 1737 190
Data Statistics
MIn717 Max:1002 Range1278
Mesni76a Medien1 864 Poins2001
810 Dav. 284 VariencB0410 Mode1863

Figure 7.4 Report Preview

Activate the file you want to print out and select File-Print on the menu bar. The following

window appears:

28]

-
Output Options

Selected Printer
HP LaserJet 2420 PCL Se

~Report Destination =
" Printer %
¢ Preview Cancel
Format:lF—‘:a.w:— Snapshot File xf.‘:;] Setup

Options-
Copies [~ Cols

[ [ Dugie

Figure 7.5 Output Options
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The dialog window in figure 7.5 has the same functions as the one in figure 7.3.

Note that as some of the files are very large, it is recommended to highlight the data you
want to print out before printing.

ro Report Preview b= ‘l:'gy
Fle Page Zoom
-”"’—“"4.‘ > >l p»?-‘i of ¥ &%mﬁloomm"s‘
@ FoodStar 251018 144740

C:\FOODSTARIMG098\11M6098.DAT

Figure 7.6 Report Preview
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8. Settings

This chapter describes the options in the Settings menu. These settings are automatically
saved when exiting the program.

8.1 Directories

The path definition can be set as Default FoodStar path structure or User defined
paths. Choose the Settings menu and the Directories command. A dialog box appears:

r T R
i Path Definition =

Set path definition as:

¢ Default FoodStar path structure:

" User defined paths

Default SeaStar path structure

Data directory: C:\FoodStar\DST milli PUAMnnnn

Type directory: C:\FoodStat\DST milli PU

User path definitior

L]

Datadirectory  |C\FoodStatDST milli PLU

Description I _j

s ]
Faes IR

oK | Cancel |

Figure 8.1 Directory Path Definition

Default FoodStar Path Structure

By choosing a DST milli-PU as a recorder type, FoodStar automatically creates a DST
milli-PU type directory in the ‘FoodStar’ directory that was created when the software was
installed on the computer. Upon connection with DST milli-PU, another directory is
automatically created under the DST milli-PU directory, which is named after the serial
number of the recorder. All data files and other files related to that recorder are stored in
this ‘serial number’ directory. Each DST milli-PU recorder has its own data directory.

User Defined Paths

If this option is selected, the User definition data directory becomes active. The data
path/directory can be defined by the user. For defining a path on the network, the
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particular drive must be mapped (under Windows Explorer) in order to browse for the
drive under ‘Add data path’.

Browse First in User Directory

With default off, the user is first directed to the path where FoodStar was installed, to
look for the INI file. If this option is enabled, FoodStar will start looking for the INI file in
the user-defined directory. More information on files and directories can be found in the
Appendix.

Create Recorder Directories

This option is default on, and means that a recorder type and serial number directory is
created for every recorder connected to.

8.2 Preferences

Units
By choosing the Settings menu, the Preferences command, and Units, a dialog box
appears:
Units “
Temperature units: Number of decimals(0-4):
@ Celsius [*C] ) Fahrenheit [°F] 2 (%

Number of decimals(0-3):

Pasteurization units are fixed ta (PU) 2 Gzé

Number of decimals{0-3):

Co2 units are fized to [g/l) 7 @

(€3]
Pressure units MNumber of decimals(0-4)
@ Pressure (Bar) ) Depth (fthm] 2 %
Depth [m] ) Pressure [psi) >
‘ 0K l I Cancel ]

Figure 8.2 Temperature and Pressure Unit Dialog Box

Select Units

The user defines whether degrees Celsius or Fahrenheit are used as a unit for
temperature measurements. The pressure measurements can be displayed as pressure
(bar), depth (m), fathoms (fthm) or PSI. Number of decimals for the values can be
selected.
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8.3 Data File Format

By choosing the Settings menu, the Preferences command, and Data File Format, a

dialog box appears:

Date Format

-
i Data File Format

|

Date format

& dd mm yy
" mmdd yy

Time separation

& Colon[:)

" Dat[.)

Date and time column definition

¢ Joined date and time

(" Seperate date and time

Date separation

& Dotf[.]
" Slash [ /)

Field separation

& Tab

" Space

Select decimal point;:

& Commal.)

" Dot(.)

Cancel I

Figure 8.3 Data File Format Dialog Box

The user defines whether the date should be shown as dd mm yy (day, month, year), or
mm dd yy (month, day, year).

Date Separation

The user defines whether a dot, slash or dash should be used to separate the date.

Time Separation

The user defines whether a colon or a dot should be used for the time separation.

Field Separation
For the text files created, the user defines whether a tab or a space should be used to

separate the fields.
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Date and Time Column Definition

If data is to be exported to other programs, it is recommended that the date and time be
joined in one column.

Select Decimal Point

The user defines whether a comma or period is used for the values displayed in FoodStar
and for text files that are created.

Pasteurisation

By choosing the Settings menu, the Preferences command, and then Pasteurisation,
the following dialog box appears:

r N
i Pasteurisation Definition lﬂﬂ—hj

Pasteurisation Temperature Start Limit {(°C) 60

oK | T Caneal

Fig. 8.4 Pasteurisation Definition

The user can select the temperature limit where the pasteurization calculations should
start. The normal/default value is 60°C.
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8.4 Connection

Choose the Settings menu and the Connection command. A dialog box appears:

P =

(&} Connection Options
|| Perform CRC test when retrieving RID

7] Check Data Echo in SNMS and updating settings in
Disconnect and Retrieve Data

If data is in the recorder then:

' Don't retrieve the data automatically
() Automatic data retrieval upon connection

@ Ask user whether to retrieve the data

(V| Perform Comparison test on RID in SNMS

] 0K \ ! Cancel ‘

Figure 8.5 Connect and Retrieve Data Options

Perform CRC Test when Retrieving RID

The CRC test is a safety check performed by the software when retrieving Recorder
Information Data (RID). If the CRC test is not successfully carried out, it means that some
errors have occurred in the transfer of files or constants, between the recorder and the
computer. If a CRC test failure occurs, the user is notified. Normally, this option should
always be selected.

Check Data Echo in SNMS

Normally the Check Data Echo in SNMS and updating settings in Disconnect and
Retrieve Data should be enabled (figure 8.5). In case of communication problems using a
USB serial converter the user can try to disable this option, as it will bypass data echo
checks, resulting in less restriction on communication protocol.

If data is in the recorder then:

Don'’t retrieve the data automatically: If this option is enabled, data retrieval is done
manually via the recorder wizard or by choosing the File menu, and Retrieve Data
command.

Automatic data retrieval upon connection: By enabling this option, the software will
automatically check for data in the recorder upon connection and retrieve it.

Ask user whether to retrieve the data: By enabling this option, you will be asked
whether you want to retrieve the data or not each time you connect to the logger.
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Perform Comparison Test on RID in SNMS

The comparison test takes place when the PC has sent all the settings data to the
recorder and it reads the whole file back and compares to what was sent. Bad
communication can cause errors in the information file when read back. If the data echo
check is enabled it is assured that the information file was transferred correctly to the
recorder, therefore it is OK to disable the comparison test.

8.5 Retrieve Data

Choose the Settings menu and the Retrieve Data command. A dialog box appears:

i} Retrieve Data Options &J

Retrieve number of data according to;

& Last saved number of byte: 0
Equivalent number of measurements 0

" User defined number of byte

" The whole recorder memory:

Recorder capacity:  Byte 65214
:Measurements 21738

Figure 8.6 Retrieve Data Options

Retrieve Number of Data

With default settings, the software retrieves the last measurement sequence recorded.
The user has the option of retrieving older data that is still in the recorder’s memory. By
choosing the User defined number of data, the number of measurements retrieved from
the recorder can be set.

As the complexity of measurement intervals give incoherence in the calculation from
measurement number to the number of data byte to retrieve, the user has the option to
define number of bytes to retrieve.

If for some reason or another it becomes necessary to retrieve data more than once or
even several times, the previous DAD and MIT files are not overwritten before a backup
has been made. The backup files are in the same directory as the “original” or the last
DAD file.

A backup number system is in use that marks the first retrieved file as number one, the
second number two etc. The number sign # is used to identify the backup up files.
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Thus if a data file has for example the name 25M1106.DAD then the backup file, that was
the first retrieval, gets the name 1#25M1106.DAD, and the 25M1106.MIT file that is
associated with the DAD file, is backed up as 1#25M1106.MIT.

8.6 View Data

Choose the Settings menu and the View Data command. A dialog box appears:

2} View Data Definition C=arenl X

v View Data Trend [*.DAT] after Conversion

v View Data Trend [*.DAT) after Measurement Sequence Selection

v View Data Trend [*.DAT) after ReConversion
[T View Time Synchrone Data [*.TSD] after ReConversion

[~ View Rate Of Change data (*ROC) after ReConversion

Cancel |

Figure 8.7 View Data

Select View Data Trend after data retrieval/conversion to view the data right after data
retrieval.

Select View Data Trend after Measurement Sequence Selection to work with
measurement data while offline.

With all the options in FoodStar, the user may want to do a lot of reconverting
(<File\Reconvert Data>) on data files after defining the preferences; changing units, data
formats, OOR settings, TSD settings, ROC settings, offset settings and converting
different sections of the data file, all of which result in numerous files. To ease the task of
remembering settings and results and/or renaming and copying files, a backup system of
reconverted files has been implemented.

A reconvert number is now associated with each sequence. This number is saved in the
recorder’s INI file and updated each time a reconvert is implemented. A copy is made of
the DAT, CIT, DAB, OOR, TSD and the ROC files with the reconvert number attached to
the filename.

Thus if a data file is for example named 5M1024.DAT, then after the first reconvert, a copy
of the DAT is named 1-5M1024.DAT, and the same naming convention is applied to the
other files.
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Each time data retrieval is performed, a subdirectory, which name is the sequence
number, is created in the data directory, where a copy of the “original” DAT, DAB, CIT
and OOR files is placed. These files have a “0-" in their names. All the reconverted files
are placed in the sequence directory. The reconvert number system is optional, and the
user can disable it in the reconvert menu. When the reconvert number system is in use,
and when viewing trended reconverted data, the reconverted “backup” file is displayed,
thus eliminating the need to close the “last” converted trend data window.

8.7 Out Of Range

If measurements are outside the calibrated range, they may seem inaccurate (mainly the
depth). The out of range measurements are shown in the OOR file (View — Measurement
Data — Out Of Range Data). The min. and max. calibration points are given in the RID file,
and in this case it should be sufficient to go directly to ‘Edit — Reconvert Definition — Data
Definition’, and choose ‘RID values’ under ‘Out of range decimal values settings’. Data is
then reconverted by choosing ‘File — Reconvert Data’. You can find more about
reconverting in chapter 10.

The user can also define the ranges. Choose the Settings menu, Out Of Range - UV
and DV definition command. A dialog box appears:

&) Set Out Of Range (OOR) Parameters SN
Decimal values (0-4095) Unit values
Min Max Min Max

Temperature ‘0 ;] m ;} ‘-5 ;} 55 ;} (-10 - 120 *C)

Pressure ’0 ;J 4095 ;J ’0 ;} 900 ;J { 0 - 3000 m)

Default
oK Previous

Figure 8.8 Set TD Out Of Range (OOR) Parameters

Decimal Values

Decimal Values (DV) are raw measurements, sometimes referred to as binary data. The
decimal value is between 0 and 4095, which is the range for the 12 bit AD converter. The
decimal values are the recorder’s calibration range. The user should not define the
decimal value range, unless he has obtained these values for that particular recorder from
Star-Oddi.

Unit Values

The decimal values are converted to Unit Values (UV), for example a decimal value of
2000 could give 20°C. The user can select a specified range for temperature and
pressure. If unit values in the data are outside the measurement calibration range of the
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recorder, the user has the option to set a max and min range for these unit values. After

selecting the unit value ranges and pressing the OK button, the following window
appears:

it

OOR Correction

DV-Correction- UV-Correction-

{* No Correction
(" Last Value

" Max/Min DV-imits

¢ No Correction
" Last Value

" Max/Min UV-limits

Cancel

Figure 8.9 Out Of Range (OOR) Correction

If no values have been selected for the Decimal Value (DV), no correction should be
selected. If Unit Values (UV) ranges were specified, the user has the option to change the
out of range measurements to the last value that was recorded before the out of range
measurement was recorded, or have it according to the max/min unit value as specified
earlier. In this case the software will know if the value is under the minimum or maximum
limit. After the correction has been made, the data needs to be reconverted under File —
Reconvert Data, and data will be changed accordingly.

8.8 Time Synchronize Data (TSD)

Choose the Settings menu, TSD definition command. A dialog box appears:

]

Time Synchronous Data Settings

[~ Make TSD file when converting DAD -> DAT

Sample Interval
¢ 1Hour

(" 10 Minutes
" 5Minutes

" 1Minute

[ Indude empty cells

Cancel |

Figure 8.10 Time Synchrone Data Settings
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If the user wants to time synchronize two or more data files, it is possible to select three
options: 1 hour, 10 minutes, or 5 minutes. The restriction is that the sample interval
selected must be greater than the initial interval, and it must also be dividable by the initial
interval. For example, if the initial interval was 15 minutes, only the 1 hour option can be
selected for time synchronizing.

If the ‘Include empty cells’ is enabled, the data tables will be empty for those
measurements in the original file that are not to be shown.

If the user wants to activate this feature, the ‘Make TSD file when converting DAD-DAT’
must be enabled. For changing the current measurement file with one of the three
intervals, the data must be reconverted by ‘File — Reconvert Data’.

8.9 Rate Of Change (ROC)

This new feature gives the user a chance to see how fast the signal is changing, i.e. the
estimated velocity of the signal. This applies to all measured parameters. The ROC is
calculated via a two point numerical differentiation:

ROC= (P2-P2)/(t2-t1)
P: Parameter expressed in a user defined unit
t: Time (hour, minute or second)

The way the ROC is set up and viewed is very similar to the TSD.
Under ‘Settings\ROC’ the ROC options can be set:

Rate Of Change Data Settings &J

v Make ROC file when converting DAD->DAT

Time Unit Selection

" hour
& minute
(" sec

" no unit (constant = 1)

[V Units are expressed with a prefix milli (E-3)

Cancel ’

Figure 8.11 ROC Definition
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The ROC is only computed when a DAD->DAT conversion is performed, and when the
user wishes. The time units are selectable as hour, minute or seconds. For small changes
it can be convenient to express the ROC as a milli (10°3) unit. For example if the depth is
in meters (m) then millimeters are expressed as (mm).

The ROC can be viewed as a trend under ‘View\Data Trend and Table\Rate of Change
(ROC)’ or as tabulated data via ‘View\Measurement Data\Rate Of Change’.

8.10 Chart

Title
Click on the title name to change the title of the chart. A dialog box appears:

r |
Chart Title 22—

Enter New Chart Title:

OK Cancel

A >

Figure 8.12 Chart Title Dialog Box

The chart is automatically assigned the data file number as a chart title. To change the
chart title, enter a new text string and press the OK button.

Time AXIS

To change the time scale of the chart, click on the X axis scale. A dialog box appears:
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r . k!
i} Axis Settings lﬂlﬂ—bj
1 (Measurement time: 10.12.2008 - 11.12.2008
Scales
v Automatic
W Aut 11.12.2008 07:54;

10.12.2008 18:01:1

DK Cancel
| |

Figure 8.13 X-Axis Settings Dialog Box

By disabling the Automatic option, the minimum and maximum time values become active.
By clicking on the Change buttons for the maximum and minimum values, the time range
can be specified. By enabling the Automatic option, the measurement time will go back to
the initial range.

Value Axis

To change the scale settings for the value axis, click on either of the Y axis scale, for
temperature or depth. A dialog box appears:

. N
) Axis Settings =68 X |

Title: |Temp

~Scales
[~ Automatic

[T Auto  Change Max | 61,145
™ Auto 19,053

oK ] Cancel [

Figure 8.14 Y-Axis Settings Dialog Box
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By disabling the Automatic option, the minimum and maximum measurement values
become active. By clicking on the Change buttons for the maximum and minimum values,
the temperature (or pressure) range to be shown on the chart can be specified. By
enabling the Automatic option, the measurements will go back to the initial range.

8.11 Chart Editor

The Chart Edit button (on every graph) gives access to the Chart Editor, a multi-option
menu, now with a Tree View interface, as can be seen in figure 8.15.

There are five main branches on the tree:
e Series

Chart

Data

Tools

Export

The tree menu gives access to the same features as the tab menu described in the user’s
manual. Most of the changes invoked are viewable immediately.

All format and style changes made to the chart, are lost if the data are viewed again or
“Reconverted”, as the *DAD and the *.DAT file are not affected by changes made to the
chart or the database.

9 Bt chant G Cl'i-"
# Senes
Temperature{"C)
Pasteursation\ = .2
= v Wressure (D
Co2(g) &ad..
« Chat v Pastour eason™))
:\:;. v CoZigh
Legend Tite..
Pand
Pagng
Wals
Data Do,

Took
Ansmabors
Dxport
Themes

Figure 8.15 Chart Editor

Series
The Series window offers the same features as the “Active Series List” button.

When a particular series is selected, like the Temperature series for example, a two tab
menu is revealed, as seen in fig. 8.16, where the user can “format” each series, and set
“points” in the graph. The tab “Point” offers visibility to points as the “Data Point Marker”
button on the graph, plus formatting of the points.
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r ; Ty
® Chart Edit e

- Series Temperature(°C) v kf_\‘}_( Line: Temperature(*t—
i Temperature(°C)
Pressure(bar) Format ‘Point | Data Source
i Pasteurisation(PU) oo x ;
- Chart Border...— | [ Dark 3D bine Mo.de.
--Axis {15t
B Titles Qolor....' [ Color Each [ Inverted
Legend - -
---Panel Pattern... [v Clickable Outline.... I
i Paging =
- Walls Height 30: [0 =l [V Color Each line
= =]
#- Tools Stack: None Rd Shadow...
- Export
Treatnulls:  Skip v Gradient...[ |

L

Close

Figure 8.16 Format Series

Chart

The chart branch has six sub branches:

AXis
Titles
Legend
Panel
Paging
Wallls

AXxis
There are 8 axes in a normal FoodStar chart. The Left, Right, Bottom and Custom O Axis
are always in use. Custom 1 axis is reserved for the timeline.

r Al
® Chart Edit [
"i:"ets *| [V visble Scales 'Tlﬂe | Labels | Ticks | Grid | Position |
3. Char i
i Ea Ap Behind Options ]Minimum | Maximum | Increment |

- Left Axis [ Atoaatic
- Right Axds Right Axis iy
- Top Axis Top Axis v Visible [T Inverted
i Bottom Axis | || |Bottom Axis
.. Depth Right |~ || [Depth Right [ Logarithmic
oeptron | |0
- Custom 0 Y Log Base: |10 [olie
“-Custom 1
- Titles
- Legend
~Panel i
- Paging
- Walls = +

Dind-

Figure 8.17 Axis Formatting
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Figure 8.17 shows a six tab Axis menu. There are numerous options, some of which can
drastically change the behavior of the graph. The Minimum and Maximum tabs give
options similar to the menu offered when clicking an axis on the graph, the ticks tab gives
access to enable and disable gridlines, just as in the “Horizontal gridline” and “Vertical

gridline” buttons in the graph.

Titles

The Titles menu shown in figure 8.18, gives access to 4 tiles, each title a multi line text
window, which can be positioned anywhere on the chart. There are multiple formatting

options, six tabs, for each title.

i
® Chart Edit

=

[#- Series
&} Chart
vAxis
B
i Title
- SubTitle
.. SubFoot
- Footer
-Legend
Panel
- Paging
- Walls
- Tools
- Export

Title b

Style IPosiﬁon I Format I Border | Text I Gradient I Shadow | Picture I

[V visble |V AdjustFrame

Text:

Alignment: Center v/

11M6098

Edit...

Legend

Figure 8.18 Titles Menu

The legend menu (see figure 8.19) gives the user an option of showing a series legend.
The 8 tab menu gives options in styling positioning and formatting the legend.

.
® Chart Edit

-

[#- Series

£} Chart

G- Axis
B Titles
& L=oend)
i Panel
- Paging
[+ Walls
- Data

- Tools

- Export

[~ visible Legend Style: Automatic

[ Inverted Text Style: Left Value

[V Font Series Color

No check boxes v

Style IPosiﬁon | symbols | Tite | Format | Border | Text | Grad ¢ [»

Vert. Spacing: |0 =l

Dividing Lines... I

v

v

=

Figure 8.19 Legend Menu
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Panel

The Panel menu (see figure 8.20) offers panel format options. Images, pictures and icons
can be imported onto the panel as a back image.

7

.
:® Chart Edit &l
Series Color lBorders | Margins ] Gradient | Shadow l Image I
=) Chart
B Axis cobr...C]
- Titles
-~ Legend [~ Default
& Panel
- Paging
G- Walls [~ Back Image Inside
-Data
#-Tools
- Export

Close

Figure 8.20 Panel Menu

Paging

With the Paging menu, shown in figure 8.21, the data series can be chopped into pages,
with a user defined number of points per page. Only one page is shown at a time, and the
user can scroll through the pages via the page buttons, that appear (are enabled) on the
chart to the right of the Edit Chart button, when paging is selected.

Paging can be useful for viewing distinct time periods, one at a time, days or hours for

example. No offset is offered and sampling periods and start time can limit the usefulness
of this option.

r 3y
® Chart Edit o
»»Series
El-Chart Points per Page: [0 i n

¥ Axis
- Titles [V Current page Legend
~Legend |V Scale Last Page
-Panel
[~ Show Page Number Edit... I
- Walls [~ Auto scale axis
& Tools Page 1of 1
- Export
A

Figure 8.21 Paging Menu
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Walls

[ Crart it o

#-Senes

= Chirt
¥ A
3 Tites

¥ {fsble Wals saecfo =

Left gt | Bottom | Back |

Legand oo, [O| I visble
Panel ’
Fagng Border., —‘; =
Left Datterry ™ Auso Hde
fught >
Botsom gadent..[@| ™ Tansowes
B —————
Data Pogition! - b
T Stag: |
*. Start
Export v b -
Endi J100 = Treparency: 0 -3
Imege

Figure 8.22 Walls Menu

The walls menu, as seen in figure 8.22, gives access to configuration of four walls, but as
FoodStar charts are default defined as 2D, only the “Back” wall is visible.

The Walls menu, has similar options as the Panel menu, when defining a pattern, via the
“Pattern...” button, as seen in figure 8.22, an image can be imported and placed on the
wall. In fact, as the Back Wall lies “on top” off the panel, a pattern or an image can
enhance an image on the panel, or the image on the panel can be seen through the wall
with the Transparency option.

Data

In the data menu, seen in Figure 8.23 gives the user access to the database, upon which
the chart rests. Here text labels can be set to each measurement point. Changes can be
made to the time and measurement values. Changes made to the data, are included when
the data is exported, but if the data are viewed again or “Reconverted” all changes are
lost, as the *.DAD and the *.DAT file are not affected by changes made to the database.

» Chart Edit

Figure 8.23 Data Menu
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Tools

Under 'Tools' you will find several options to customize the setting of the cursor and the
appearance of the graph, such as page numbering, font, font size etc. To

active/deactivate the chosen setting check/uncheck the 'Active’ box on top of the first
page of this menu.

f ® Chart Edit [_Jﬂﬁ-‘
z:r:ts Add... ‘ Delete I vV Active 4
-Data
g EEcusor |
i - Cursor Page Number
: -Page Number fAgc Rectangle
. Rectangle
- Export
Figure 8.24 First Page of Tools Menu
Export
Under the Export menu, three tabs offer as many menus for saving data as:
Pictures
Native (data)
Data (file)
Pictures
[ Chart edit [=5=)
Series Picture | Native Data
#- Chart
Data Series: Lndudt_a:
Tools (all v ; Eomt int;e:(
H Em“t 'oint Labels
- “Format: I [V Header
@ Text [~ Paint Colors
T XML
(" HTML Table Delimiter:
" Excel Tab x
g Text Quotes:
Copy | Save... | Send... I

Figure 8.25 Export Menu: Picture
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Figure 8.25 shows options when saving the chart as a picture to a file, or copy the picture
to the clipboard. There are seven format possibilities:

e Metafile
e Bitmap
e JPEG

o GIF

e PDF

e VML

e SVG

Native
The Native menu, see figure 8.26, data is saved as “Native” *.tee chart files. Import of
these files is not supported in FoodStar at the moment.

<
( ® Chart Edit (o]
G- Series Picture Native IData |
B Chart
i-Data ¥ Indude Series data
[#- Tools
: - Format:
(¢ Binary
" Text
XML *
[~ File size: ?
I Save... I Send... I
L

Figure 8.26 Export Menu: Native

Data
Data can be exported to files in four formats, see figure 8.27.

Text file (.txt)
XML (.xml)
HTML (.hml)
Excel (.xIs)
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:® Chart Edit l&]

- Series Picture | Native Data
[#- Chart
. Data Series: Lndudg:
B Tooks (al) = ™ Point Index
[V Point Labels
Format; v Header
@ Text [~ Point Colors
7 XML
(" HTML Table Delimiter:
" Excel Tab 2 l
Text Quotes:
Copy ] Save... ] Send... ]

|

Figure 8.27 Export Menu: Data

There are four Include options:

1. Point Index
The point index is the same as the measurement number, but offset by -1, as it
starts in O instead of 1.

2. Point Labels
If the user has added text labels to points in the DATA menu, these can be
included.

3. Header

The same headers as are in the DATA menu.
4. Point Colors

This option is not relevant in FoodStar.

Another method for exporting is to use the Alt+PrintScreen keyboard buttons to copy an
image of the FoodStar window to the clipboard, thereafter to paste it to another Windows
application. When a dialog box is open, then only that frame is copied to the clipboard.
To copy a part of a data file, for example from a DAT file, then highlight the part you want
to copy and use the Ctrl+C keyboard buttons to copy the data snippet to the clipboard.

Then use the paste-option in another Windows application to transfer the data from the
clipboard.
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Figure 8.28 Highlighted Text to be copied

8.12 Templates
There are two scenarios where templates come in handy:

1. When many recorders are programmed with the same settings (multi mode), and
circumstances are in a way that the user cannot complete the setup of all the
recorders in one session, and he has to exit FoodStar (to continue later).

2. When the user wants to reuse, partly or completely, presumably a complex and/or
lengthy measurement setting.

Saving a Template

The user can now, when editing New Measurement Settings (NMS), save his work by
enabling “Save this NMS as a Template (file)” option (see fig. 8.29), before
acknowledging OK from the Edit NMS menu. Having selected this option and the NMS
are OK, the user has an option to write a description for the template (see fig. 8.30).
Canceling this option cancels the ‘save template’ operation. The template is an INI file and
saved in the FoodStar\NMS directory. The name of the file is MST<date><type
letter>time<Interval mode>.INI.
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& Set New Measurement Sequence [F=NEE] %_J
Set start time

Start date: 119_ 9.2011 ol
Start time: Hour 14 : Min 9 :

Set measurement interval time

Hours @ 3.4

Minutes |0 :

Seconds 10 X
oo s
& Single mode
" Multi mode

[ Save this NMS definition as a Template [file]

0K | Cancel

i

Figure 8.29 Template Options in Edit\New Measurement Sequence

Save NMS as Template

Template Name: MST2112010C092253S]

Template Description: l

oK | Cancel

Figure 8.30 Saving NMS as a Template

Using a Template

Templates can be retrieved at a later time to be used directly or modified. The list of
templates is kept in the FoodStar\templets.ini file.

There are three buttons in the Edit NMS window as can be seen in fig. 8.31. The top
button is used for retrieving a template.

As can be seen in fig. 8.32, templates are selected via template name or description.
Parallel to selecting a template, descriptions can be edited and eventually templates
deleted.
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The recorder type and interval type, which the template was based on, are visible for each
template.

) Select Termplate SRCE - x

Inderval Tyom Pamary Recosds Typs

Tenghate name | MST 158201 TM17043154 -

M desorgtion |

Delste tomplats

ay Carcel

Figure 8.31 Template Selection

Templates can be used across recorder type boundaries and interval types.
Things to keep in mind when selecting a template are:

e Single interval templates converted to a multiple interval NMS. All seven intervals
are the same.

e Multiple interval templates converted to a single interval NMS, set the interval as
interval one.

e Start time in the past is not allowed as will be apparent when exiting the Edit NMS
window.

e Some recorder types are less compatible than others, an example of that is a DST
milli template converted to a DST GPS NMS.

After selecting a template the user is returned to the edit window. If the selection is not as
what the user expected the “Previous” button will return the previous setting.

The user has one more option to quickly set up the NMS. The button in fig. 1, marked
“Use Default”, will return default NMS settings. The button can have four descriptions and
return four different settings depending on the status of recorder and measurement
selection.

Use Default: No recorder selected.

Use Recorder: Recorder selected but not a measurement sequence.
Use Sequence: Measurement sequence selected.

Use Online: Recorder is on-line.

PONPE
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9. Multiple Intervals

FoodStar has the option for setting up more than one sampling interval within a
measurement sequence. Reasons for wanting multiple intervals can be to save memory,
but still be able to have frequent measurements in between. If you want to run on a single

interval the whole recording period, this option is not selected.

Select Multiple recording intervals in the wizard or choose the Edit menu and the New
Measurement Sequence Definition command. Select Multiple Intervals and the
following dialog box appears:
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Figure 9.1 Set New Measurement Sequence (with multiple intervals)

9.1 Start Time

The user defines the date and time when recordings should start.

9.2 Measurement Interval

The sampling interval (time between measurements) is defined. Any value from 1 to 99
seconds, or 1 minute to 24 hours with increments of 1 minute. Up to 7 different sampling
intervals can be selected. If for example two intervals will be used, then only two intervals
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need to be filled out. If seconds are used as sampling interval, the multiple of the sampling
interval and the number of measurements must be dividable by 60.

9.3 Number of Measurements N1-N7

The user defines the number of measurements to be recorded within each sampling
interval. A value from 1 to 60000 must be set. Please note that an initial measurement is
taken at the defined ‘start time’. This initial recording is not counted as a measurement for
the ‘Interval 1’ number of measurements. For example if the recorder should measure
every hour from midnight to ten o’clock (00:00 — 10:00), then the number of
measurements defined should be 10. Please note that only this one measurement at the
‘start time’ does not count as a measurement for the intervals. In this case, the first
measurement counted for the ‘Interval 1’ is at 01:00, and the last measurement is at
10:00, and then it shifts to another interval.

After taking one measurement at the ‘start time’, the recorder will start on the first interval
in the sequence and take the number of measurements as defined. After taking the
measurements on the first interval, it will automatically shift to the next interval etc. The
sampling intervals and number of measurements will recycle until memory is full, or until
connection is made with the recorder through a PC computer.

9.4 Sequence 1-14

The interval sequence must be filled out. As shown in figure 10.1, the user selects to use
intervals 1-6 for the recordings. Another example:

If two of the first sampling intervals are used, the sequence should be 1, 2, 1, 2 etc,,
meaning that the recordings shift between the first and the second intervals, recording the
defined number of measurement for the first interval, and then shifting to the second
interval taking the number of measurements defined. The shifting between the intervals
repeats until memory is full, or until connection is made through a PC computer.

9.5 Primary/Secondary

With default setting, both temperature and depth is recorded at each sampling interval
(TD normal). The user has the option to select either temperature or pressure/depth as a
primary sensor for each sampling interval. The objective with this feature is to save
memory size, increase recording period, and get more data on the sensor that is of more
interest (primary sensor).

©2014 Star-Oddi. All Rights Reserved Page 65



Distributed By MicroDAQ, LLC  603-746-5524 www.MicroDAQ.com
User Manual FoodStar Graphic Supporting Software

The secondary counter is only meaningful if a primary parameter has been selected. The
secondary counter defines how frequently the secondary parameter is saved along with
the primary parameter. If for example pressure/depth is selected as a primary sensor, and
the number 3 is defined as a secondary counter, the temperature will only be recorded
every third time when pressure/depth is recorded. If the value is O (zero), the recorder is in
principle a depth recorder only, except the first measurement is always a temperature and
depth (TD) measurement.

There are restrictions on the secondary counter settings when multiple intervals are
defined. If a primary parameter is selected and secondary counter is O then the ‘Number
of meas.’” for the primary counter must be an even number. If a primary parameter is
selected then the ‘Number of meas.” must be dividable by the secondary counter, and
only odd numbers (0,3,5,7...255) can be used as a secondary counter.

The Use Template can be used if older definitions have been saved by enabling the ‘Save
this NMS as a template (file). That way it's possible to get templates that have been set
up in the past. With the Use Sequence button it is possible to get same settings as from
other recorders, by browsing for their serial no. By hitting the Previous button the settings
go back to previous, before changes were made.
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10. Reconvert Data

In FoodStar you have the option of reconverting data that has already been retrieved.
After re-defining parameters, the data is reconverted by ‘File — Reconvert Data’. The main
reasons for reconverting data are:

e Shift pressure/depth values according to a reference meter, to increase accuracy.
e Adjust measurements that are outside calibration range.

e Incorrect PC-time at measurement start time.

e Need for temperature or pressure unit alteration.

e Need for data file format alteration.

10.1 Data Definition

Under the Edit menu and Reconvert Definition, choose the Data Definition command,
and the following dialog box appears:
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Figure 10.1 Reconvert Data Definition
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Set Reconversion Measurement Sequence Start-Time

If the user notes from retrieved data that the PC date and clock were incorrect when
measurements were started, it is possible here to specify a new start date and start time.

In Reconversion use Measurement Intervals from

The measurement interval is either the interval settings as shown in the measurement
(MID) file, or if that interval is incorrect, a new and correct sampling interval is specified in
the ‘New Measurement Sequence Definition’ command in the ‘Edit’ menu.

In Reconversion use Constants from
The user can choose to use calibration constants from:

e MID file. This option should normally be selected, as it contains information on the
constants from the measurement sequence.

e RID file. The recorder information file contains the same calibration constants as
the MID file, except if it has been re-calibrated. If it has been re-calibrated, and the
user wants to use the new constants on older measurements, the RID option
should be selected.

e RBD file. This option rarely needs to be selected. If the constants from the MID
and RID file are corrupt, the user should contact Star-Oddi for an RBD file. See
chapter A.3 for instructions on how to transmit the RBD files to the recorder.

Convert Number of Data

The user can reconvert all the data in the last measurement sequence, or define the
number of measurements to be reconverted. The user has the option to define what
measurement range should be reconverted (for example to exclude data points when the
recorder was above water).

Time Linear Adjustment

The real time clock inside the DST has an accuracy of approximately +/- 1 minute per
month. This slight variation might accumulate over time and influence the measurement
results. To correct the gradual time shift first check “linear adjustment time” then type in
the time offset value and the length of the measuring period.

Out of Range Decimal Value Settings

Measurements that are outside the calibration range are inaccurate, and may give
erroneous results. The out of range (OOR) measurements can be seen in the OOR file.
The user has the following decimal value out of range detection options when
reconverting:

e Full scale (no boundaries). This means that literally no ‘out of range’ detection will
be made.
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e User definition. With this selection the range definition under ‘Settings - Out Of
Range - DV definition’ will be used. This option is selected when the decimal
values (DV) are not available in the RID file. This would normally require the user to
contact Star-Oddi for the decimal values.

e RID values. The calibration decimal range is given in the RID file. This is the
default option and should normally be selected.

If an RBD file exists in the \FoodStar\RBD folder, then FoodStar recognizes this file as a
primary source for DV calibration range. In this case, the fourth option appears and is set
as default.

Temp. correction outside temp. calibration range
The user can choose to apply Pressure temperature correction for measurements that are
outside the temperature calibration range.

Normal correction: Pressure measurements are always temperature corrected
Limit correction: Pressure Temperature correction is limited to calibration range
No correction: Pressure Temperature correction is not applied.

10.2 Temperature Definition

Under the Edit menu and Reconvert Definition, choose the Temperature Definition
command, and the following dialog box appears:

(7 Temperature Reconvert Definition | = || =3 I
Temperature offset adjustment

@ Mo offset adjustment

0

Offset adjustment value [m°C]

Use at next data retriewval for this recorder

Single spike correction

z Time g =
" | Use single spike correction | SES Y]

| Slope correction Limnit 0

Dive: Temperature response shift

Enabled
1

1

Linear estimation outside calibration range
[] Use linear estimation outside calibration

[] Use at next data retrieval for this recorder

Note: This overrides 00R correction definition

‘ oK ! l Cancel [

Figure 10.2 Temperature Offset Correction Menu
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Offset Adjustment

When recorders are used over a long period of time, the temperature measurements can
start to deviate from correct values.

When checking older recorders, it has come apparent that the error in the measurements
is mainly due to an offset. Some users feel they can benefit from an offset correction
option in FoodStar, for example when a recorder has been in the water for a long time and
is later tested to show an offset. The offset is defined in m°C (1000 m°C = 1°C).

Single spike correction
Check Use Single Spike Correction. There are two variables, Time and Limit. The Limit
defines how much difference can be between two points over a defined Time.

If a point is outside the range, +/- the limit of adjacent points. That point is then calculated
as the average of the adjacent points.

Temperature response shift

It is possible to set the desired start/end point to be shifted by X seconds. This shift can
only be performed on data with an interval of 1 second.

Linear estimation outside calibration range

Check this option to linearly estimate temperature measurements outside of calibration
range.
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10.3 Pressure Definition

Under the Edit menu and Reconvert Definition, choose the Pressure Definition
command, and the following dialog box appears:

(&) Pressure Reconvert Definition =N ] @
Disable temperature correction in pressure calculation
Pressure offset adjustment Pressure linear adjustment
@ No offset adjustment @ No linear adjustment
Dffset adjustment value [mBAR] |0 & Linear adjustment value (mBaR) | ” ®
Time span (days) |1 =
Negative slope correction
Use at next data retrieval for this recorder 9 Fosiiz=rshps concelon
Linear estimation outside calibration range
_ | Use linear estimation outside calibration
| Use at next data retrieval for this recorder
Note: This overides D00R corection definition
Single spike comection
Time
| Use single spike correction 0 (S Tl
| Slope correction Limit
Freeze temperature correction in pressure step
|| Use fixed temperatur correction in pressure step
From 1 = To 10 = Temp[T] 12

€] €3]

Perform fixed temperature corection
| oK w ! Cancel

Figure 10.3 Pressure Reconversion Definitions

Disable Temperature Correction in Pressure Calculation

In case the temperature sensor is malfunctioning in a way that it will indicate very high
temperature values, it will offset the pressure calculation. An automatic temperature
correction is set by default in FoodStar. To turn off this feature, check the box next to
“Disable temperature correction in pressure calculation”.

Pressure Offset Adjustment

The user can increase accuracy of pressure recordings by finding an offset value, which is
the difference between a recorder’s pressure value and a reference meter’s value. Once
the offset point has been set in, the data can be reconverted, and all pressure recordings
shifted according to the value defined (in mbar).

In cases where a drift has occurred with the pressure recordings, the pressure data can
be corrected if the user has a known reference point for correcting the data. To find the
offset value, the recorder should be deployed in water, at a known depth (preferably >2 m
depth), or placed along with an accurate reference depth meter, where a reference point
can be taken. Once the offset value has been found, the offset pressure value is put in the
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window shown above. The offset value can either be subtracted or added to the pressure
values.

When using 9.81 as g, the coefficient for converting cm into mbar is 1.019, for example:
100 cm = 101.9 mbar.

If the ‘Use at next data retrieval for this recorder’ is enabled, the offset value is fixed for
that particular recorder, and future data uploads of the recorder will use the offset value
defined, for shifting the pressure data. The offset value will apply only to that particular
recorder, and other offset values can be defined for other recorders.

In case the temperature sensor is malfunctioning in a way that it will indicate very high
temperature values, it will offset the pressure calculation. An automatic temperature
correction is set by default in FoodStar. To turn off this feature, check the box next to
“Disable temperature correction in pressure calculation”.

Pressure Linear Adjustment

Aging of the pressure sensor can result in an offset of the measured pressure values. To
correct these offset values you can select a linear pressure adjustment. Check “linear
adjustment value” and fill in the pressure offset value (difference between expected value
and real value at the end of the recording period) and the length of the measuring period.

Linear Estimation outside Calibration Range

The pressure sensor tolerates a significantly higher pressure than its calibration range. If
the recorder is exposed to higher pressures than its calibration limit it will result in
erroneous data. By choosing this option you will receive more adjusted values. Please
note that since these values are outside of the calibration range an exact adjustment is not
possible, this feature is mainly for estimation purposes.

Single spike correction

Check Use Single Spike Correction. There are two variables, Time and Limit. The Limit
defines how much difference can be between two points over a defined Time.

If a point is outside the range, +/- the limit of adjacent points. That point is then calculated
as the average of the adjacent points.

Step Correction

The Step Correction option is mainly intended for those users who are doing research on
fishing gear such as long lines and trawl doors, although it might benefit other users as
well.

When the recorder has been on deck for a long time there is a significant temperature
change when it hits the water and as a result the normal temperature corrector might not
function correctly In order to avoid inaccurate measurements, the user has the option of
using a fixed value in the temperature correction.
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In the From field (see figure 10.3) enter the number of the measurement when the sensor
hit the water and in the To field enter the number of the measurement when the
temperature became stabilized. In the Temp field enter the temperature value of the latter
measurement. This fixed value is then used to correct the pressure value.

The graph in figure 10.4 displays the difference between normal correction (red line) and
step correction (blue line).
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Figure 10.4 Normal Vs. Step Correction

Units and Data File Format

Using the Settings menu and Preferences, you can change the format of the
measurement units and the data file.

Reconvert Data

For reconverting the data, the data file must be open. To reconvert, select the File menu,
and choose the Reconvert Data command. The data file is reconverted and conversion
data files are created (CIT, DAB, DAT). A new chart file is opened.
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View Previous Conversions

Each time a reconversion is performed, a numbered file is created in the sequence folder.
To view previous conversions select a file under View and choose Previous as can be

seen in figure 10.5.
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Figure 10.5 Previous Conversions

The window in figure 10.6 appears. Select a numbered file from the drop-down list.

@ Select previous conversion =] =D (IS |

oK

Cancel |

=

Figure 10.6 Select Previous Conversions
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Reconvert Previously Retrieved Data

If data from the same sequence is retrieved more than once, a bookmarked data
sequence file (DAD) is created. These files can be accessed and reconverted by
choosing File-Reconvert data-Previous as can be seen in figure 10.7.

View Wumd: Window Hep

FoodStar 109 - DST il PU -

Figure 10.7 Reconvert Previously Retrieved Data
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11. Recorder Modes

In this chapter, the three operational modes of DST milli-PU are described, that is the PC
Mode, Sleep Mode and Measurement Mode.

11.1 PC Mode

If the recorder is in the correct position in the Communication Box, and by choosing the
Recorder menu and the Connect command, the recorder is put into PC Mode. At the
bottom of the FoodStar window, the text On-line is displayed, indicating that the
recorder is on-line and in PC Mode.

While in PC Mode, the recorder will remain in an active listening stage. The
communication protocol is a simple master/slave arrangement, in which the recorder is
the slave. The slave will perform every command the PC issues, and after execution of a
command, it will return to listening. When the recorder is connected to the PC, it is
powered by the PC, and not taking energy from the battery inside the recorder.

11.2 Sleep Mode

The user receives the recorder in Sleep Mode, but it can easily be awakened by the
Connect command in the Recorder menu. If the recorder is not set in Measurement
Mode, it goes into Sleep Mode when the recorder is removed from the Communication
Box. When the recorder is in this mode, less energy is depleted from the battery.

11.3 Measurement Mode

The recorder is put into Measurement Mode by choosing the Recorder menu, and Start
New Measurements Sequence. The recorder starts recording measurements according
to the start time (date/month/year) and sampling interval (hours/min.) defined by the user.

When the memory is full, the recorder shifts automatically into Sleep Mode. If the recorder
is still in Measurement Mode upon connection through a PC computer, it stops recording
and is put into PC Mode.
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12. Memory and Battery

12.1 Memory Organization

The memory capacity in DST milli-PU is 21738 measurements of temperature and
pressure. Data is kept in an EEPROM memory and will not be lost if the battery fails or
expires. The memory of the recorder is organized as shown in the figure below:

Data memory

—
=

—
<

Settings —=

Unused memory/

NEIEE e Old recordings

Figure 12.1 Data Memory Organization

When data is retrieved from the recorder, the following occurs:
1. The computer retrieves the data from the recorder and writes the data to the
computer’s hard drive.
2. The recorder has stopped recording, but still holds the recorded data.

When new settings are sent to the recorder, the following will occur:

1. New settings are sent to the recorder.
2. The data memory pointer is reset to the beginning of the data memory and starts to
write over older recordings.

The organization of the memory is now as follows:

Data memory

'

-
~

Settings —>
Unused memory/
Old recordings

Figure 12.2 Data Memory with New Settings
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12.2 Battery Calculations

The voltage characteristics of the batteries used in our recorders make it almost
impossible to measure the energy available in the batteries, therefore we estimate the
energy consumption by calculation. All the energy consuming functions of the recorder,
like sleep, decay, running (microprocessor awake), measurements and saving data are
measured beforehand and used in our calculations. The calculations are performed by the
application software’s, SeaStar, Mercury and FoodStar. The recorders themselves do
not perform any energy calculations, but in order to start the recorder in one computer
and retrieve data in another while still having the battery energy information, they carry the
percentage of remaining energy with them in a register file (in the RID). At the time the
recorder is in production (when the battery is new) the energy number is set to 100%.

Each time the recorder is started up in a new measurement sequence, the energy
consumption, since last sequence-start, is calculated and subtracted from the energy
number retrieved from the recorder, and this new energy-left number is downloaded into
the recorder.

The energy-left register in the recorder can be corrupted for reasons such as:

e The CRC check is turned off when connecting to the recorder and a
communication error occurs

e When a write error occurs when starting up a new sequence or updating a status
to the recorder and a reconnection is performed instead of performing the
operation again.

e Energy estimation calculations are not in accordance with actual energy
consumption.

To change/correct the battery energy numbers in the recorder refer to chapter 13.5.
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13. Wizards

There are six wizards in FoodStar:

13.1 Connection Wizard

Connection Wizard

If using a communication box:
Connect the box to the computer and insert the DST
If using a StarCom cable:
Connect cable between the recorder and computer

CcoM1

Close ]

Figure 13.1 Connection Wizard

Choose the Wizards menu and the Connection Wizard command to enter the
connection wizard (see figure 13.1).

13.2 Com Box Connection

Com Box é}
Connection
Check Yellow Light
Figure 13.2 Com Port Wizard

Choose the Wizards menu and the Com Box Connection command to enter the Com
Port wizard (see figure 13.2). The wizard goes through available ports and activates them
one at a time and asks the user to confirm that the communication box displays a yellow
light (see figure 13.3).
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COM1 {0]
Did the yellow PC-com light turn on? - 4
l Yes [ Mo l

Figure 13.3 Com Port Wizard

13.3 Start Recorder

Choose the Wizards menu and the Start Recorder command to enter the wizard (see

figure 13.4).
Start Recorder é’

Recorder Type

Connection

Define Measurement Sequence
Start Recorder

Figure 13.4 Start Recorder Wizard

This wizard starts the recorder with a new user defined measurement sequence.

13.4 Retrieve and View Data

Choose the Wizards menu and the Retrieve Data command to enter the wizard (see

figure 13.5).
Retrieve Data é}

Recorder Type
Connection
Retrieve Data
Start Recorder

Figure 13.5 Retrieve Data Wizard

This wizard retrieves data from the recorder and offers the user to start it again with a new
measurement sequence.
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13.5 Quick Retrieve and Restart Recorder

Choose the Wizards menu and the Quick Retrieve command to enter the wizard (see
figure 13.6).

Quick Retrieve and :
Restart Recorder

Connection

Retrieve Data

Define Measurement Sequence
Start Recorder

Figure 13.6 Quick Retrieve Wizard

This wizard retrieves data from the recorder without graphically displaying it and offers the
user to start it again with a new measurement sequence.

13.6 Change Battery Life
A new wizard has been added to the Wizards menu, the Change battery life wizard.

Choose the Wizards menu and the Change battery life command to enter the Change
battery life wizard (see figure 13.7).

Change battery Iife@

Recorder Type

Insert Recorder

Connection

Set New Battery Life

Write Battery Life To Recorder

Repeat Wizard

Figure 13.7 Change battery life
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Select the recorder type and insert the recorder in the Communication Box. Once a
connection has been established a window appears (see figure 13.8). If the recorder is
already on-line then the wizard will start in step 4 (Set New Battery Life).

r
L) Set Battery Life I = *%I

Total sleep-time (weeks) D9 batteryused (%) 34

Recorder definition: Battery life left ( %) 64

" Direct definition: Battery life left ( %) o

(¢ Calculate from NMS, measurement weeks, and sleep time:
Calculate NMS Weeks measuring: s 3
Estimated measurement battery usage pr, week (%) 0.77

Calculated total battery used ( % ) 46
Calculated battery life left (%) 54

OK | Cancel J

Figure 13.8 Set Battery Life

The top line shows who long the recorder has been in use since (last) calibration, and
how much energy sleep and decay combined have used up over that time.

The second line shows Battery left based on the register in the recorder.
There are two ways to set the battery life, Direct definition and Calculate from NMS.

Direct definition:

Check the Direct definition option and set the battery life (in %) manually based on for
example, the last known “good” value and an estimated/guessed value on energy used
since then. The user can also refer to other same type recorders working under similar
conditions.

Calculate from NMS:

Check the Calculate from NMS option and click on Calculate NMS. The user is now
transferred to the Set New Measurement Definition window where a sequence can be
defined. Once the measurement sequence has been defined an Estimated measurement
battery usage pr week (%) is calculated and shown in the Set New battery Life
window, note that sleep and decay energy use is included in this number. Also the
Calculated total battery used (%), which is based on the NMS definition times number
of weeks, plus the energy used by sleep and decay.

Now insert for how many weeks the recorder (since produced) has been measuring. Each
time the number of weeks is changed, the Calculated total battery used(%) is
recalculated, note that the Calculated total battery used(%) value will not show a
directly weeks * energy pr week, as the sleep + delay values must be accounted for.
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Appendix

A.l Directories and Files

Directory Structure

The user can choose between FoodStar’s default data directory structure (path) or define
his own data path. The directory structure branches from the directory where FoodStar is
positioned down to type directories, i.e. DST milli-PU. From there it branches again into
recorder directories, named after the serial numbers of the recorders, designed to hold
data for each individual recorder (data directory). All in all it is a three level directory
structure.

An example of this directory structure with DST milli-PU is:

C:\FoodStar\ The installation directory (FoodStar.exe location)
C:\FoodStar\DST milli-PU\ The type directory for DST milli-PU
C:\FoodStar\DST milli-PU \M6098\ The directory for the M6098 recorder

When a new recorder type is selected in FoodStar (File — New Recorder Type), the
directory for that recorder type is created. When connecting to a recorder for the first
time, FoodStar creates the recorder directory, named after the serial number of the
recorder.

Information Files

FoodStar uses information files to store and retrieve settings. There are two types of

information files:

1) The type-INI files, (for example DSTM.ini for DST milli-PU).
The information type files are all in the installation directory, they contain information on
specific settings for each type. The type-INI files are:

2) The recorder-INI files, for example M6098.ini contains settings information and data
file positioning for the M6098 recorder. The recorder-INI files are located in the
appropriate type directory, i.e. all the Mxxxx.INl files are in the ‘DST milli-PU’ directory.

Files Locations

As stated previously, the type-INI files are placed in the ‘FoodStar’ directory, and the
recorder-INI files are placed in the recorder type directory. All other recorder and
measurement related files created by FoodStar are placed in the appropriate recorder’s
directory. For example:

C:\FoodStar\DST milli-PU\M6098\ is a directory for the M6098 recorder and all files
belonging to M6098 are placed there.

If the user wishes to use his own defined data path, for example C:\Data\, then all the files
for all the recorders, except for the INI files, are placed there. If the user has enabled the
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“Create recorder directories” in the user path definition, individual recorder directories,
irrelative to type, are created under the user defined path, for example: C:\DATA\ M6098\
for the M6098 recorder. The M6098.ini file (located in the C:\FoodStar\DST milli-PU\)
contains the path to the C:\Data\ M6098\ directory, and all files related to the M6098 will
be placed in that particular directory.

Browsing for a Recorder

When browsing for a new recorder from the ‘Select recorder’ under the files menu, the
default method is to find a recorder-INI file in the type directory. The INI file will then point
to the data directory (the recorder’s directory). If the user has enabled the “Browse first in
the user directory” in the user path definitions, the search starts in the user defined
directory, where a *.RID file must be selected.

Recorder Related Files

Every file that is recorder related has the following name format:
Mxxxx: The name is the serial no. of the recorder

Ext Description File type
RID Recorder information data Binary
RIT Recorder information text Text
RBD Recorder backup data Binary
RDD Recorder SNMS* download information data Binary
RDT Recorder SNMS* download information text Text

*SNMS: Start New Measurement Sequence

The recorder ID (RIT) can at a later time be opened, and the related measurement data
can be viewed, printed and reconverted. The RDD, RDT and DIR are downloading
information files, created when a new measurement sequence is started.

Measurement Related Files

Every file that is specifically measurement related has the following name format:

mmmMxxxx: The name is the measurement number + serial no.

Ext Description File type
MID Measurement information data Binary
MIT Measurement information text Text
MDD Measurement download information data Binary
MDT Measurement download information text Text
CIT Measurement conversion information text Text
DAD Measurement Data Binary file Binary
DAB Measurement Data Binary file Text
DAT Measurement Data Binary data Text
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The MID, MIT and DAD files are created upon measurement data retrieval from the
recorder. The DAB, DAT and CIT files are created when converting the data. The MDD
and MDT are download information files and created when a new measurement sequence
IS started.

Data Files

Upon data retrieval, three main data files are created.

The *.DAD File

This file is the raw data source file. The data is in mixed binary form. The user cannot
access this file in the FoodStar program. When converting these raw data into
measurements, the *.MID file is needed. The result from the conversion are two data files,
the * DAB and the *.DAT.

The *.DAB File

This file contains sequential binary representation of the data in columns. The first column
is the measurement number. The other columns contain the measured parameters in a
binary form.

The *.DAT File

This is the actual result file, where the measurements are converted to their natural units
and timed. This is a text file with columns. The first column is the measurement number,
the second column the date and the time, depending on the set-up. The third column is
the time or the first measured parameter, depending on set-up. The following column(s)
contain the converted measured parameters with units and number of decimals according
to set-up. Number of parameters can range from 1-3, and number of columns 3-6
accordingly.

Data Header

The *.DAT file contains a data header, which is a detailed description of how the *.DAT file
is configured. This feature is used by FoodStar when graphically representing the data,
and is practical if the user wants to import the data into other applications or databases.
Most of these descriptive items are derived from the ‘Settings’ menu and the recorder
type definition in the ‘File’ menu.

Each header item is contained in one line, and all header lines start with a # (bookmark)
and a number. Then follows a description of the header item, and then 1-4 directives, all
separated by tabs. Eventually a comment trails the directives, preceded by a ; (semicolon)
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The following is a description of the directives contained in the data header.

Item

Description Number of directives

#0

#1

#2

#3

#4

#5

#6

#H7

#8

#9

Date-time: 1
The date and time of that particular *.DAT file creation.

Recorder: 1
The recorder and sequence number, f. example 12M1023
Used for confirmation and as a graph header.

File type: 1

Describes file column structure, mainly if Date and Time are joined
(0-3)

0: Result file  Number Date Time Channels 1-3

1: Result file  Number Date & Time Channels 1-3

2: Binary file  Number Binary Channels 1-3

Columns: 1
Total number of columns (3-6).

Channels: 1
Number of measurement parameters (1-3).

Field separation: 1

Separation between columns (0,1)
0: Tab

1: space

Decimal point: 1
(0,1)

0: Comma

1: Dot

Date def.: 1
Date format (0,1)
0: dd mm yy

1. mm ddyy

Time def.: 1

Time separation (0,1)

0: Colon (?)

1: Dot (.)

Channel 1: 4

Set as left axis, normally temperature. The four directives are:
Axis header, unit: Text

Column header, unit: Text

Number of decimals: (0-3)

Axis direction (1,2)
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1 Ascending
2: Descending

#10 Channel 2. 4
Set as right axis, normally pressure. The four directives are:
Axis header, unit:  Text
Column header, unit: Text
Number of decimals: (0-3)
Axis direction (1,2)
1 Ascending
2: Descending

#11 Re-conversion: 1
Definition on conversion / Extra header in graph (0,1)
0: Original conversion
1: Reconverted

#12 No temperature correction: 1
Only in re-conversion, temperature correction in pressure calculations, is used as
extra header information (0,1)
0: Normal correction
1 Correction was disabled

#13 Pressure offset correction:2
In pressure calculation, a zero offset can be adjusted. The two directives are:
Applied: (0,2)
0: No adjustment was made
1: A zero offset was adjusted.
Adjustment value:  An integer value in mbar

#14 Channel 3. 4
Set as extra right axis. The four directives are:
Axis header, unit: Text
Column header, unit: Text
Number of decimals: (0-3)

Axis direction (1,2)
1 Ascending
2: Descending
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A2 Help Menu

Choose Help and the following window appears:

" @ FoodStar 360 - DST malli PU-#x - CAFoodStanDST mll UL [

[PowOn (Coml |

|Help topics [

Figure A.1 Help Menu

User Manual
Select User Manual to open the FoodStar user manual.

Troubleshooting
Select Troubleshooting to open the Trouble-Shooter.

Release Notes

Select Release Notes to view a description of the latest features added to FoodStar, the
date when they were added and a reference to the chapter number of the manual where
the additions can be found.
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PU-Calc
Select PU-Calc and the following window appears:

Pasteurization Calculator li_h,l
Select Result Parameter
@ Time duration {minutes); 50
" Temperature setpaint ('C) 60
" Pasteurisation Units (PU) 17
] calc \ Exit

Figure A.2 PU-Calc

FoodStar calculates dissolved Co2(g/l) based on temperature (°C) and pressure (Bar).
T= Temperature

P= Pressure

Co2= 10*(P+1.013) * e™(-10.73797 + (2617.25 / (T+273.15)))

The PU calculator calculates one value from two other related values. The user selects
which value is the result value and defines in the two other values.

In figure A.2 time has been selected as the result parameter. By writing in the temperature
and PU values, the calculator calculates the time when clicking the Calc button.
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Check for Updates

Select Check for Updates to manually update the latest version of FoodStar, User
Manual, Trouble-Shooter and Release Notes. The following window appears:

&) Select files to download = S

[~ Application

[~ FoodStar.3.11.zip (0,00 B)
[ Help

[~ Foodstar.pdf (0,00 B)

Files Selected: 0
Total Size: 0,00 B

x|

Figure A.3 Select files to download

Select the files you want to download and click OK. The program downloads and installs
the latest updates to the software. Please note that this can only be done when the
program is offline i.e. when no recorder is connected to the program.

Change Log is displayed if a new application version is available while updating (see

figure A.4)
) Select fies to download |
[~ Apphcaton 3.5
[~ FoodStar,3.52.2p (2,55 ME) Bug fx:
DAT 8= mas rot deplayed correctly
woraphcaly

3.50

For logger types that support
Remperadre only thers S now a
Temperatire only logger” checkhox n the
WMS Time and Energy cak.” settings

| Thee result of data retnevl & now lagged,
bytes recened X of ¥

QOR forme were redesgned

Foxed a bug where reconvert would be
5 ¥ -
Fdes Selected: & deabled after & logger measurament was
Total Sze: 0,008 pelected
Fxed a bug where “Save ‘Window Data®

Cancet I would have an incorrect destination folder
nftwe racnewaeenn

Figure A.4 Change Log
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By selecting Settings-Options-Update you can now choose whether you want to update
FoodStar manually, every X number of days or every time FoodStar is run (see figure
A5).

Settings e
{Update |
Check for updates

" Manually

{" Every |30 :} days

(¢ Every time FoodStar is run

Last check was 0 days ago

OK | Cancel

Figure A.5 Update

Submit ticket

Tickets can now be sent directly from the application to our support department by
selecting Help-Submit Ticket. A shortcut key, F1, can also be used at any time while in
the application and is especially useful when the menu bar is disabled.

In the ticket form (see figure A.6) you can add your name and email. Select a category
that best describes your problem and write a subject and description. If you like you can
select Images (screenshots) and browse for images in the screenshots folder and send
them with the ticket. By selecting Other files you can also add files to the ticket. To
automatically add recorder data use the Include Recorder Data option. By default the
following files are included: screenshot, system information, logs and settings. These can
be excluded with options in Other files.

To receive a response we require that you include a valid email address.
Tickets can also be created by e-mailing support@star-oddi.com with the problem
description and files attached.
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If you want to add more information to a previously created ticket you can reply to the
support response.

& Submit Ticket |23
Name ] Incude Recorder Data
' None
Email l o
s " &l Re
Category ICommunlcat]on _ﬂ ,

Message ]Images (screenshots) I Other Files I

Subject l

oK | Cancel

Figure A.6 Submit ticket

About
Select About for general information about FoodStar.

A3 Recorder Backup

As mentioned in chapter 10, if the constants from the MID and RID file are corrupt, the
user should contact Star-Oddi for a RBD file and transmit it to the recorder. The name of
the backup file is Txxxx.RBD (serial no. of the recorder plus the .RBD ending).
Downloading the backup file:

Copy the backup files (RBD) into the FoodStar RBD directory.

Open the FoodStar software.

Plug a recorder to the PC computer.

Select the 'File' menu and 'Recorder backup' command and the following window
appears:

PONPE
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Select a recorder *.RBD file E]
Leia i- |3 RBD -] £ Ef

4] C4665,RED 4] k2348 RBD 4] Q0003 RED

4] C4795.RED 4] K2350,RED 1] 51523.RED

1410119, RED 4] 2351, RED 4] Y0677 RED

4] K2336,RED 1] ME8411,RED

14 K233, RED 1] ME419 RED

4] K2343. RED 4] MB452.RED

1] K2344 RED 4] Q000 1.RED

4] K2345, RBD 1] QO00Z.RED

Heifihltar QR ~|
Hlutir af gerd: |F|ecorder Backup Data file{C" bd] ﬂ Haztta vid

Figure A.7 Select a Recorder *RBD File

Browse for the correct RBD file on the computer and click OK.

5. Insert the sequence number and remaining battery life (see figure A.8). Note that if the
sequence number is set too low, data will be overwritten.

Set Sequence Number and ... fz|

Seq. number from BEBD file: 0

Input new sequence number:

Fs

Set battery hfe remaining (%4) 100

| (]4 | l Cancel I

Figure A.8 Set Sequence Number

6. The FoodStar software downloads the RBD file into the recorder and the window in
figure A.9 appears. Click OK.

Backup operation g|

The recarder 1z Off-ine

The backup data are in the recarder i }
Flease connnect again |

OF.

Figure A.9 Backup Operation

©2014 Star-Oddi. All Rights Reserved Page 93



	1.  Introduction
	2.  Program Installation
	2.1 Install
	2.2 Uninstall

	3.  Preparation
	3.1 Configuration of the Communication Port
	Using the USB Serial Converter
	Using the Serial Port


	4. Communication Box
	4.1 Communication Box
	4.2 Connection Point
	4.3 /COM Connection
	4.4 /Connection Wizard

	5.  Using DST - Tutorial
	5.1 DST milli-PU Set Up
	Step 1 - Start Program
	Step 2 - Connect
	Step 3 - Connect to the Recorder
	Connection Time Registration

	Step 4 - Set New Measurement Parameters
	Step 5 - Start a New Measurement Sequence
	NMS Calculation

	Step 6 - Retrieve Data
	Step 7 - Disconnect
	Step 8 – View Data


	6.  View Data
	6.1 Open Data
	Import
	Buttons
	Active Series List
	Horizontal/Vertical Gridlines
	Data Point Marker
	Histogram
	Save Window Data
	Print Chart

	Zoom Out
	Zoom In

	Adjust Axis
	Open file in PatternFinder
	Chart Edit
	Templates
	/ Display table completely
	/ Partial table display
	/ Hide table

	Using the Mouse
	Max and Min Values
	Zoom
	Scroll the Chart
	Go Back to Initial View
	Change the Axis
	Change the Title


	6.2 The View Menu
	Data Trend and Table
	Recorder Information (RIT)
	Recorder Calibration Information (RCI)
	Recorder Download Information (RDT)
	Viewing Text Files
	SNMS LOG File
	Measurement Data
	Measurement Download Definition (MDT)
	Measurement Information (MIT)
	Conversion Information (CIT)
	Statistics in CIT
	Out of Range (OOR)
	Binary Data (DAB)
	View DAB Files as Trend
	Binary Pressure Temperature Corrected Data (BPD)
	Converted Data (DAT)
	Time Synchrone Data (TSD) and Rate of Change (ROC)

	FoodStar Log
	Screenshots

	6.3 Opening data in Excel
	Joined Date and Time
	Separate Date and Time


	7.  Printing
	7.1 Charts
	Orientation
	Margins
	Move
	Details

	7.2 Histogram
	7.3 Files

	8.  Settings
	8.1 Directories
	Default FoodStar Path Structure
	User Defined Paths
	Browse First in User Directory
	Create Recorder Directories

	8.2 Preferences
	Units
	Select Units


	8.3 Data File Format
	Date Format
	Date Separation
	Time Separation
	Field Separation
	Date and Time Column Definition
	Select Decimal Point
	Pasteurisation

	8.4 Connection
	Perform CRC Test when Retrieving RID
	Check Data Echo in SNMS
	If data is in the recorder then:
	Perform Comparison Test on RID in SNMS

	8.5 Retrieve Data
	Retrieve Number of Data

	8.6 View Data
	8.7 Out Of Range
	Decimal Values
	Unit Values

	8.8 Time Synchronize Data (TSD)
	8.9 Rate Of Change (ROC)
	8.10 Chart
	Title
	Time Axis
	Value Axis

	8.11 Chart Editor
	Series
	Chart
	Axis
	Titles
	Legend
	Panel
	Paging
	/Walls

	Data
	Tools
	Export
	/Pictures
	Native
	Data


	8.12 Templates
	Saving a Template
	Using a Template


	9.  Multiple Intervals
	9.1 Start Time
	9.2 Measurement Interval
	9.3 Number of Measurements N1-N7
	9.4 Sequence 1-14
	9.5 Primary/Secondary

	10.  Reconvert Data
	10.1 Data Definition
	Set Reconversion Measurement Sequence Start-Time
	In Reconversion use Measurement Intervals from
	In Reconversion use Constants from
	Convert Number of Data
	Time Linear Adjustment
	Out of Range Decimal Value Settings
	Temp. correction outside temp. calibration range

	10.2 Temperature Definition
	Offset Adjustment
	Single spike correction
	Temperature response shift
	Linear estimation outside calibration range

	10.3 Pressure Definition
	Disable Temperature Correction in Pressure Calculation
	Pressure Offset Adjustment
	Pressure Linear Adjustment
	Linear Estimation outside Calibration Range
	Single spike correction
	Step Correction
	Units and Data File Format
	Reconvert Data
	View Previous Conversions
	Reconvert Previously Retrieved Data


	11.  Recorder Modes
	11.1 PC Mode
	11.2 Sleep Mode
	11.3 Measurement Mode

	12.  Memory and Battery
	12.1 Memory Organization
	12.2 Battery Calculations

	13. Wizards
	13.1 /Connection Wizard
	13.2 /Com Box Connection
	13.3 Start Recorder
	13.4 Retrieve and View Data
	13.5 Quick Retrieve and Restart Recorder
	13.6 Change Battery Life

	Appendix
	A.1 Directories and Files
	Directory Structure
	Information Files
	Files Locations
	Browsing for a Recorder
	Recorder Related Files
	Measurement Related Files
	Data Files
	The *.DAD File
	The *.DAB File
	The *.DAT File

	Data Header

	A.2 Help Menu
	User Manual
	Troubleshooting
	Release Notes
	PU-Calc
	Check for Updates
	Submit ticket
	About

	A.3 Recorder Backup


